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1 What’s New in This 
Update of the User 
Guide?

TIP:  Need help? Go to http://www.ca9.uscourts.gov/cmecf/feedback/ and submit your question. 
You can expect a reply from the Court during the Court’s business hours, from 8:30 AM to 
5:00 PM Pacific Time.

This topic lists the additions and updates that were incorporated in each update of this guide.

September 18, 2013 Update
Updated the step-by-step instructions in “Submitting a Brief for Review by the Court” on page 79 
to reflect the changes in the fields that appear during the filing.

June 29, 2013 Update
• Updated the filing types available in the Briefs filing category (1 new filing type: File 

Presentence Report UNDER SEAL) in “Filing Categories and Types of Motions” on page 178.

• Updated “Types of Motions Available When Filing a Motion” on page 181 to add motion to 
transmit exhibit.

March 21, 2013 Updates
• Updated guide to remove references to specific size limitation for PDF files.

At the Startup Page window, click the Court Information link to see the current size limit.

• Updated “Attaching PDF Documents to Filings” on page 65 to include the View button that is 
now available so you can review what you attached before committing a filing.

• Updated “Submitting a Brief for Review by the Court” on page 79 to include information about 
submitting excerpts with your brief.

• Updated the filing types available in the Briefs filing category (2 new filing types: File a 
Streamlined Request to Extend Time to File Brief and Submit Excerpts of Record for Review by 
the Court) in “Filing Categories and Types of Motions” on page 178.
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What’s New in This Update of the User Guide? >  
February 10, 2012 Updates
• Revised entire guide to reflect menu label change, from Docketing to Filing.

• Updated “Submitting Electronic Versions of Original Petitions” on page 35 and “Bar 
Admission and Appellate ECF” on page 150 to reflect new windows and more streamlined 
processes.

• Added a new topic, “Checking a PDF File Before Filing” on page 63, to explain how to check 
your PDF documents before you try to upload them into Appellate ECF.

November 1, 2011 Updates
Updated “Bar Admission and Appellate ECF” on page 150 to reflect new windows and processes; 
also added new topic that explains how to submit payment for admission if you were previously 
admitted without paying the admission fee (fee waiver).

October 5, 2011 Updates
Updated all illustrations to match the current version of Appellate ECF.

August 7, 2011 Updates
• Updated “Macintosh Users and Appellate ECF” on page 126 to include additional 

configuration information.

• Updated “Filing Categories and Types of Motions” on page 178 to reflect the addition of one 
new filing type: File an Acknowledgment of Hearing Notice.
Also added one illustration of a filing category with filing types and removed the illustrations 
from each individual filing category section. Reorganized the content for better readability.

February 18, 2011 Updates
Updated illustrations and instructions related to Pay.gov payments in the topics listed below. The 
name of the person who logged in to Appellate ECF and contact information are now required.

• “Submitting Electronic Versions of Original Petitions With Fee Payment” on page 36

• “Paying the Case Opening Fee for an Original Petition” on page 70

• “Submitting an Application for Admission With Fee Payment” on page 151

• “Requesting and Paying for a Certificate of Good Standing” on page 161

• “Requesting and Paying for a Duplicate Admission Certificate” on page 164

February 14, 2011 Updates
• Added additional configuration information in “Getting Started” on page 13:
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What’s New in This Update of the User Guide? >  
• Added “Add-On Toolbars” on page 16

• Added “Allowing Pop-Ups From the Court” on page 18

• Updated “Java” on page 16

• Updated “Macintosh Users and Appellate ECF” on page 126 to include additional 
configuration information.

• Changed “motion to file late petition for rehearing (to file motion and petition for rehearing 
together)” to “motion to file late petition for rehearing (to file motion and petition for rehearing 
on same day)” to reflect change in relief description in Appellate ECF. See “Types of Motions 
Available When Filing a Motion” on page 181.

December 17, 2010 Updates
Added information about how to request and pay for Certificates of Good Standing and Duplicate 
Admission Certificates. See “Requesting and Paying for a Certificate of Good Standing” on 
page 161 and “Requesting and Paying for a Duplicate Admission Certificate” on page 164.

December 1, 2010 Updates
• Added chapter with instructions for uploading original petitions and paying court fee. See 

“Submitting Electronic Versions of Original Petitions” on page 35.

• Added chapter with instructions for submitting application for bar admission using Appellate 
ECF. See “Bar Admission and Appellate ECF” on page 150.

• Updated “Filing Categories and Types of Motions” on page 178 to reflect the addition of a new 
filing category, Pay Case Opening Fees.

September 26, 2010 Updates
• Added instructions on how to check installed Java version on a Macintosh system. See 

“Prerequisites for Mac Users Running Mac OS X 10.6 or Lower” on page 128.

• Updated “Filing Categories and Types of Motions” on page 178 to reflect the addition of two 
new filing types:

• Submit Amicus Brief by Government or With Consent per FRAP 29(a)

• File a Reply to an Answer to an Original Petition

• Updated “Filing Categories and Types of Motions” on page 178 that the Answers to Original 
Petitions filing category was renamed to Original Petitions.

• Updated illustrations as needed throughout the guide to reflect minor changes in the interface.
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What’s New in This Update of the User Guide? >  
December 11, 2009 Updates
Updated illustrations “To set Firefox as the default browser and clear the browser cache and 
cookies” on page 131 to reflect Firefox 3.5.5 user interface.

December 1, 2009 Updates, new Fed. R. App. P. and Circuit Rules
• Updated illustrations throughout the guide to reflect Federal Rules of Appellate Procedure and 

Ninth Circuit Rules changes that went into effect on December 1, 2009.

• Removed references to CADS, Civil Appeals Docketing Statement, and replaced with 
Mediation Questionnaire. See Circuit Rule 3-4, Mediation Questionnaire, for additional 
information.

• Removed references to Transcript Designation.

• Changed filing category Transcripts/Court Reporters to Court Reporters.

• Updated illustrations and steps throughout the guide to document change in warning dialog box 
that opens after starting the filing of a document. See “Screen Resolution” on page 17 and 
Illustration of warning dialog box updated to show single Continue checkbox.

August 1, 2009 Updates
• Updated logging in instructions and illustrations to reflect new checkbox that must now be 

selected to acknowledge that you understand that in order to file, you must comply with the 
redaction rules. See “Starting Appellate ECF” on page 20.

• Updated Macintosh users requirements. With the 2.1.3 release of Appellate ECF, Macintosh 
users must update their system to have the latest Java updated released by Apple in June 2009. 
See “Prerequisites for Mac Users Running Mac OS X 10.6 or Lower” on page 128.

July 9, 2009 Updates
• Added additional warnings throughout the guide about the size limit for PDF attachments.

• Added new chapter with step-by-step instructions for filing a petition for rehearing. See “Filing 
a Petition for Rehearing” on page 106.

• Added note about remote electronic access to documents in Social Security cases and 
immigration matters in “Document Links in a Notice of Docket Activity” on page 116.

• Updated “Types of Motions Available When Filing a Motion” on page 181 in “Filing Category: 
Motions/Responses/Replies” on page 180 to include some reliefs that were previously only 
available when submitting a brief and a motion together: motion to file a late brief, motion to 
file nonstandard brief, and motion to file oversized brief.
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What’s New in This Update of the User Guide? >  
June 19, 2009 Updates
• Updated “To set Firefox as the default browser and clear the browser cache and cookies” on 

page 131 in “Macintosh Users and Appellate ECF” on page 126 to include illustrations and 
additional steps.

April 25, 2009 Updates
• Updated illustrations as needed throughout the guide to reflect minor changes in the interface.

• Completely revised and updated “Starting Appellate ECF” on page 20. Added additional 
illustrations, steps to change browser settings, and instructions for dealing with warning dialog 
boxes that may open.

April 17, 2009 Updates
• Updated “Macintosh Users and Appellate ECF” on page 126 to include additional 

configuration steps for filers who use a Macintosh system.

March 30, 2009 Updates
• Updated “Filing a Court Reporter Motion to Extend Time” on page 102 to include information 

about fill-in form available at Court website.

• Updated “Filing Categories and Types of Motions” on page 178:

• File a Response to a Motion renamed to File a Response to a Motion/Form

• File a Response to a Motion/Form added to the Forms/Notices/Disclosures category

• Added motion to extend time to file FRAP 9a memorandum to “Types of Motions 
Available When Filing a Motion” on page 181
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What’s New in This Update of the User Guide? >  
March 14, 2009 Updates
• Updated guide to reflect changes in ECF version 2.1.1.

• Changed “Supported Browsers” to “Hardware and Software Requirements” on page 16 and 
included new information. Moved the “Screen Resolution” on page 17 topic into this new 
section.

• Expanded “Filing a Motion” on page 88 to include illustrations for each step of the filing 
process.

• Added new chapter, “Filing a Court Reporter Motion to Extend Time” on page 102. This 
chapter provides step-by-step instructions for filing a court reporter motion using the Appellate 
ECF system.

• Added new chapter, “Macintosh Users and Appellate ECF” on page 126. This chapter provides 
information for Intel-based Mac users.

• Updated “Filing Categories and Types of Motions” on page 178 to reflect the addition of two 
new filing types:

• File a Response to a Court Order

• File a Reply to a Response to a Court Order

March 2, 2009 Updates
• Added new chapter, “Updating Your Appellate ECF Account” on page 168. This chapter 

provides step-by-step instructions for updating a company’s name or address, and for updating 
contact information for a registered attorney if that attorney changes firms.

February 23, 2009 Updates
• Updated “Submitting a Brief for Review by the Court” on page 79 to include illustrations for 

each step of the filing process.

• Updated “Filing Categories and Types of Motions” on page 178 to reflect changes in labels of 
filing types: File Court Reporter Motion renamed to File Court Reporter Motion to Extend 
Time

January 9, 2009 Updates
• Updated “Filing Categories and Types of Motions” on page 178 to reflect changes in labels of 

filing category changes: Court Reporters/Transcripts renamed to Transcripts/Court 
Reporters

• Updated “Filing Categories and Types of Motions” on page 178 to reflect changes in labels of 
filing types and to include new filing types:
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What’s New in This Update of the User Guide? >  
• File Correspondence to Clerk Related to Pending Case (9th Cir.R.25-2) renamed to 
File Correspondence to Court

• File Court Reporter Correspondence to Clerk Related to Pending Case renamed to 
File Court Reporter Correspondence to Court

• (New filing type) In the Briefs category, added File an Errata to a Brief

• (New filing type) In the Rehearing/Reconsideration category, added File a Reply to an 
Answer to a Petition for Rehearing/En Banc

• Updated “Checking the Service List for a Case” on page 68

November 8, 2008 Updates - Version 2.1
• Updated “Screen Resolution” on page 17

• Updated: “Completing an Electronic Filing” on page 50

• Updated: “Selecting the Filing Party” on page 58

• Updated: “Attaching PDF Documents to Filings” on page 65

• Updated: “Submitting a Brief for Review by the Court” on page 79

• Updated: “Types of Motions Available When Submitting a Brief and Filing a Motion Together” 
on page 179

• New: “Creating Cross-Document Hyperlinks” on page 117

September 18, 2008 Updates
• New: “Filing a Motion and a Response to a Motion Together” on page 96

• Other minor updates throughout the guide.

September 9, 2008 Updates
• New: “Submitting a Brief for Review by the Court” on page 79

• Updated: “Filing a Motion” on page 88 (minor updates)

• New: “Filing Categories and Types of Motions” on page 178
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2 Getting Started

The topics below provide information that you may find useful when using ECF in the United 
States Court of Appeals for the Ninth Circuit.

• “Typographical Conventions Used in This Documentation” on page 14

• “Appellate ECF Application Overview” on page 15

• “Hardware and Software Requirements” on page 16

• “Starting Appellate ECF” on page 20

• “Stopping ECF” on page 27

• “Updating Your Account Information” on page 28

• “Screen Resolution” on page 17

• “Windows in ECF” on page 29

• “Drop-Down Lists” on page 31

• “Radio Buttons” on page 32

• “Date Fields” on page 33

• Checking the Service List for a Case
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Getting Started >  Typographical Conventions Used in This Documentation
Typographical Conventions Used in This 
Documentation
This documentation uses the typographical conventions described in Table 1.

Table 1.  Typographical Conventions

Formatting Description Examples

text Fixed Courier font.
Used for text that you must type in exactly as 
shown, for keyboard keys that you must press, 
for predefined values in drop-down lists.

In the Confirm field, type YES.

Press Alt-F1.

text Bold.
Used for labels in the user interface of ECF, 
such as area labels, field names, and button 
labels.

From the Category drop-down list, 
select Motions.

text Italic.
Used for variable information that you must 
enter in ECF. Also used for new terms when 
they are first defined in the guide.

In the Attorney field, type the name of 
the attorney for the case.

In the Date field, type today’s date.

In ECF, the File Date is the date that the 
Court considers something filed.

> Greater than sign.
Used to indicate a navigation path in menus.

Choose Reports > Service List.
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Appellate ECF Application Overview
Case Management/Electronic Case Files (CM/ECF) is an automated case management and 
docketing system designed specifically for the federal courts. The case management and docketing 
(CM) portion is used by the courts. The electronic case files (ECF or Appellate ECF) portion 
allows courts to manage documents electronically; provide 24-hour desktop access to case files by 
judges, court staff, and the public; and accept filings over the Internet.

Electronic case files are documents stored in electronic format instead of on paper. Documents can 
be created electronically by parties and court staff or paper copies can be scanned. All documents 
are stored in Portable Document Format (PDF).

The Appellate ECF portion of the system is easy to use and allows a court to store, retrieve, review 
and send case documents in a reliable and secure electronic format. Appellate ECF also offers the 
following benefits:

• Twenty-four hour access to case files from any location

• Remote document filing

• Concurrent access to files

• Immediate e-mail notification of case activity to parties and court staff 

• Easy public access

• Secure storage of documents
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Hardware and Software Requirements
The information in this section will help you to determine which hardware and software you need 
to run ECF.

Supported Browsers

Appellate ECF has been tested successfully using Firefox 4.0, and Internet Explorer 8 and 9 as 
representative browsers. All testing was performed using the Java Plug-In version 6 (also referred 
to as 1.6).

Browsers available from Google (Chrome), Opera Software (Opera), and AOL are not officially 
supported.

Add-On Toolbars

Add-on toolbars, such as the Google, Bing, Yahoo, and Earthlink toolbars are known to interfere 
with ECF, so we strongly suggest that you do not download or install add-on toolbars unless you 
know how to configure those toolbars so that they do not interfere with ECF.

Java

You must have at least Java Version 6 Update 1 to use ECF. We recommend that you always 
download and install the latest update available. 

If you do not have Java on your computer (or if you aren't sure if you do) go to http://
www.java.com/. You will note that there is a question/link below the Free Java Download button 
which asks Do I have Java? If you are not sure whether you have it, this link will run a diagnostic 
check on your computer and let you know whether it is already loaded. If you need to download or 
update Java, simply click the Free Java Download button and follow the directions on the 
subsequent pages. The Java Version 6 download is free, and the program takes only a few minutes 
to load.

CAUTION:  We have determined that there may be a compatibility issue between Appellate ECF 
and Internet Explorer used with Java 6 Update 18 and higher.

To fix the issue, you must disable a setting in Java:

1. Close all browser windows.
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2. Click Start > Settings > Control Panel > Java.

This opens the Java Control Panel.

3. In the Java Control Panel, click the Advanced tab.

4. Expand the Java Plug-in node and clear the checkbox labeled Enable the next-generation 
Java Plug-in (requires browser restart), as shown in Figure 1.

5. Click the OK button.

Screen Resolution

The minimum screen resolution required to run Appellate ECF is 1024 x 768 pixels. If the screen 
resolution for your workstation is lower, you must change the resolution before you start using 
ECF. You do not have to make any changes to your screen resolution if the current setting is higher 
than 1024 x 768 pixels.

CAUTION:  If you do not adjust your screen resolution, you may not see all the information you 
need to see in order to enter a filing in ECF. 

For example, when you click the Continue button at the File a Document screen, the system will 
open a warning dialog box that you need to review in order to continue the filing. You may not be 
able to see all the information in that warning dialog box if your screen resolution is not high 
enough. In order to proceed with a filing, you must select the Continue checkbox before clicking 
the OK button.

Figure 1.  Java Control Panel, Java Plug-in
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An example of a complete warning dialog box is shown in Figure 2. For each warning dialog box, 
you must (1) select the Continue checkbox and then (2) click the OK button to proceed with the 
filing.

Macintosh Users

The Apple Macintosh platform can now be used to run all parts of the ECF with no extra software. 
See “Macintosh Users and Appellate ECF” on page 126 for details.

Allowing Pop-Ups From the Court

Several reports and utilities in Appellate ECF open in a new browser window or tab:

• History Report

• Service List

• PACER Report

• Notice of Docket Activity after entering a filing in a case in Appellate ECF

• Payment window from pay.gov that allows you to complete payments

Figure 2.  A Warning Dialog Box in Appellate ECF
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To check for and disable pop-up blockers for Appellate ECF

1. Turn on the sound on your system.

2. Log in to Appellate ECF.

3. Choose Reports > Service List. 

If you hear a distinctive “ding,” you know that something is blocking the web page from 
opening. 

4. Make sure you change the pop-up blocker settings to allow all pop-ups from Appellate ECF 
(ecf.ca9.uscourts.gov).

Additional Information About Technical Requirements

For additional information about technical requirements, please see What equipment and software 
do I need to file? and the FAQs available at the Court’s website (http://www.ca9.uscourts.gov/
cmecf/faqs) and at PACER (http://www.pacer.gov/psc/efaq.html#CMECF)
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Starting Appellate ECF
After you log in to Appellate ECF, the Startup Page window opens. 

1. Open a web browser window and navigate to the following URL:
https://ecf.ca9.uscourts.gov/cmecf/servlet/TransportRoom?servlet=Login 

The Appellate ECF Login page, shown in Figure 3, opens.

CAUTION:  Notice the checkbox labeled “I understand that, if I file, I must comply with the 
redaction rules. I have read this notice.” You must select this checkbox to log in to Appellate 
ECF.

2. Make sure you select the redaction rule checkbox to acknowledge that you understand that 
you must comply with the redaction rules. The checkbox is located immediately above the 
Authentication box. 

3. In the Login field, type your Appellate ECF login name and in the Password field, type your 
password.

CAUTION:  The Login and Password fields are case-sensitive.

Figure 3.  Appellate ECF Login Page
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4. (Optional) In the Client Code field, enter a code to identify the person using the account.

This information is only referenced by PACER.

5. Click the Login button.

NOTE:  If the cookies settings are not acceptable for Appellate ECF, the system shows an error 
message above the Authentication box. The message will say “You must enable cookies in 
order to use this system.” An example of the message is shown in Figure 4.

If this message appears, do one of the following:

• If you are using Internet Explorer, go to Step 6 on page 22.

• If you are using Firefox, go to step Step 7 on page 23.

Figure 4.  Cookies Not Enabled Message
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6. To change cookies-related settings in Internet Explorer, do the following:

a. In Internet Explorer, choose Tools > Internet Options.

b. In the Internet Options dialog box, click the Privacy tab.

c. Under Settings, click the Sites button.

d. In the Per Site Privacy Actions dialog box, in the Address of Web site field, type 
ecf.ca9.uscourts.gov and click the Allow button.

The Managed Web Sites list should now contain an entry for uscourts.gov, and the 
setting should be Always Allow. An example of what the dialog box should look like is 
shown in Figure 5.

e. In the Per Site Privacy Actions dialog box, click the OK button.

f. In the Internet Options dialog box, click the OK button.

g. Restart Internet Explorer and go back to Step 1 on page 20.

Figure 5.  Per Site Privacy Actions Dialog Box - Correct Settings
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7. To change cookies-related settings in Firefox, do the following:

a. In Firefox, choose Tools > Options.

b. In the Options dialog box, click the Privacy icon at the top.

c. Under History, from the Firefox will drop-down list, select
Use custom settings for history.

d. Click the Exceptions button.

e. In the Exceptions - Cookies dialog box, in the Address of web site field, type 
ecf.ca9.uscourts.gov and click the Allow button.

The Site/Status list should now contain an entry for ecf.ca9.uscourts.gov, and the 
setting should be Allow. An example of what the dialog box should look like is shown in 
Figure 6.

f. In the Exceptions - Cookies dialog box, click the Close button.

g. In the Options dialog box, click the OK button.

h. Restart Firefox and go back to Step 1 on page 20.

Figure 6.  Exceptions - Cookies Dialog Box - Correct Settings
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8. If a Warning-Security dialog box opens, do the following:

a. Select the Always trust content from this publisher checkbox.

b. Click the Run button.

This dialog box will only open the first time you start Appellate ECF if you follow the steps 
above. An example of this dialog box is shown in Figure 7.

Figure 7.  Warning - Security
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The following happens:

c. A browser window, shown in Figure 8, opens. 

This window, which remains open in the background, is titled CM/ECF Appellate and the 
top of the page reads “U.S. Court of Appeals CM/ECF”. The large CM/ECF button initially 
appears with a Java logo. Wait until that logo disappears and the button contains the text 
CM/ECF as shown in Figure 8. 

CAUTION:  Do not close this window at any time. 

d. The Startup Page window opens in the foreground. 

An example is shown in Figure 9 on page 26. Notice that your last login date and time are 
shown near the middle of the page.

CAUTION:  Do not close the Startup Page window at any time. If you do close this 
window by accident, find the background window, shown in Figure 8, and click the large 
CM/ECF button.

Figure 8.  CM/ECF Appellate Browser Window
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Figure 9.  Startup Page Window
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Stopping ECF
To ensure that the different pieces of the application close correctly, you should always logout from 
ECF.

1. From the menu bar of any active ECF window, choose Logout > Logout CM/ECF.

A Confirm Logout dialog box, shown in Figure 10, opens.

2. Click the Yes button.

ECF logs you out and closes all the main browser window. If you had a docket report window 
or a service list window (or tab) open, they will remain open until you close them.

Figure 10.  Confirm Logout Dialog Box
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Updating Your Account Information
The quickest way to update your account information is to navigate to the Appellate Filer Account 
Update page and submit your changes. Use this URL to get started: https://www.pacer.gov/psco/
cgi-bin/cmecf/ea-login.pl.

You can also access the Appellate Filer Account Update page from within Appellate ECF:

1. From the menu bar of any active ECF window, choose Utilities > Update My Account.

The User Account Profile window opens. 

2. Click the Edit My Information button.

A new browser window opens with the Appellate Filer Account Update page.

Review the Frequently Asked Questions at http://www.ca9.uscourts.gov/cmecf/faqs to answer 
any questions you may have about updating your Appellate ECF filer account information.

In addition, make sure you review “Updating Your Appellate ECF Account” on page 168 for 
step-by-step instructions for updating your address, firm name, and email addresses.
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Windows in ECF
In ECF, most windows are divided into several parts: a title bar, a menu bar, a screen area, and an 
area at the bottom of the window that contains command buttons. An example of a window is 
shown in Figure 11. 

Title Bar

The title bar contains the following elements: the ECF icon, the title of the window, and the 
standard window controls (minimize, maximize/restore, and close).

Figure 11.  A Window in ECF
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Menu Bar

The menu bar contains a number of menus that contain menu items or commands. In Figure 12, 
Filing, Reports, Utilities, Logout, and Help are menus. History Report, PACER Report, and 
Service List are menu items or commands.

Command Button Area

The command button area contains the buttons that let you continue or step back in a process.

In most cases, you can also use the Cancel button in this area to cancel the process you are 
currently working on. An example of a set of command buttons is highlighted in Figure 13.

Figure 12.  Menu Bar

Figure 13.  Command Buttons
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Drop-Down Lists
A drop-down list contains a set of predefined values. In Figure 14, there are two drop-down lists, 
Category and Description. In Figure 14, the Description drop-down list is the active drop-down 
list (the values that you can select are visible).

To select a value in a drop-down list
• Using the mouse, click the down arrow of the drop-down list and select a value in the list.

• Using the keyboard, type the first characters of the value to select the first matching value in 
the list.

• Using the keyboard, use the up arrow () and down arrow () to navigate up and down 
in the list and select the highlighted value in the list.

Figure 14.  Drop-Down List
ECF User Guide -  31



Getting Started >  Radio Buttons
Radio Buttons
A radio button is a control that you turn on by selecting the radio button. Radio buttons are mutually 
exclusive. This means that if you select one radio button in a group, you will not be able to select 
another radio button in that same group. In some cases, selecting a radio button changes the other 
user interface elements in the application. 

Figure 15 shows two sets of radio buttons. The set on the left represents categories, the set on the 
right represents a type of filing. In Figure 15, the Motions/Responses/Replies radio button and the 
File a Response to a Motion/Form radio buttons are selected.

Figure 15.  Radio Buttons Example
32 -  ECF User Guide



Getting Started >  Date Fields
Date Fields
A date field is a field where you must enter a date in one of the following supported formats:

• mm/dd/yy or mm/dd/yyyy 

Example: 7/2/07 

• mm-dd-yy or mm-dd-yyyy 

Example: 7-02-2007 

• mm.dd.yy or mm.dd.yyyy 

Example: 7.2.07 

In ECF, you can also fill in a date field by selecting a date from a pop-up calendar.

To use the pop-up calendar to fill in a date field

1. Make the date field the active field, right-click and choose Select Date from Calendar from 
the pop-up menu.

A pop-up window opens with a calendar, as shown in Figure 16.

TIP:  Use the navigation buttons at the top of the calendar to quickly view the calendar for 
another month and year.

Figure 16.  Calendar Pop-Up
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• Click the << button to go to the previous year without changing the month. In the example 
in Figure 16, clicking the << button would show October 2010.

• Click the < button to go to the previous month. In the example in Figure 16, clicking the < 
button would show September 2011.

• Click the > button to go to the next month. In the example in Figure 16, clicking the > 
button would show November 2011.

• Click the >> button to go to the next year without changing the month. In the example in 
Figure 16, clicking the >> button would show October 2012.

2. Click a date to fill in the date field from where you invoked the calendar.

The calendar pop-up closes.
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3 Submitting Electronic 
Versions of Original 
Petitions

You can submit electronic versions of original petitions (such as petitions for review, petitions for 
writ of mandamus, and petitions for permission to appeal) and, if a fee is required, you can pay the 
$450.00 filing fee using your credit card. If you use this feature, there is no need to send a paper 
original to the court. Note that, although your submitted documents will be deemed received as of 
the date submitted, the court may not open your case or create a docket number until the next 
business day. 

CAUTION:  If you need relief or verification of your submission before the next business day 
because of an imminent removal or deportation or because emergency relief is needed for some 
other reason you must call the motions unit at (415) 355-8020 during business hours or (415) 355-
8000 after hours. 

All attached documents must be searchable and must be accompanied by proof of service by mail 
or other method of service by the filer directly (no electronic service available through Appellate 
ECF). 

The following topics are included:

• “Submitting Electronic Versions of Original Petitions With Fee Payment” on page 36

• “Submitting Electronic Versions of Original Petitions Without Fee Payment” on page 44

• “Reviewing Your Submissions” on page 48
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Submitting Electronic Versions of Original 
Petitions With Fee Payment
Before you start, make sure you have all the PDF files ready to upload.

All attached documents must be searchable and must be accompanied by proof of service by mail 
or other method of service by the filer directly (no electronic service available through Appellate 
ECF). 

CAUTION:  Before you start, you must ensure that there are no pop-up blockers that prevent you 
from seeing the payment page. The payment window from Pay.gov opens in a new browser 
window or browser tab. 
The easiest way to check is to turn on the sound on your system, then try to access the Service List 
(Reports > Service List). If you hear a distinctive “ding,” you know that something is blocking the 
web page from opening. Make sure you change the pop-up blocker settings to allow all pop-ups 
from the Court’s site.

Submitting original petitions with a fee payment consists of two steps:

1. Initiating the submission and selecting the PDF files to submit. See “To select the PDF files to 
submit,” below.

2. Completing the payment and submitting the PDF files to the Court. See “To pay and complete 
the transaction” on page 40

To select the PDF files to submit

1. In the Startup Page window, from the menu bar, choose Utilities > Submit New  
Case With Fee Payment, then choose the appropriate option:

• Agency or Immigration Petition (Fee)

• Petition for Writ of Mandamus (Fee)
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An example of the Utilities menu with the options is shown in Figure 17.

The Submit New Case With Fee Payment dialog box opens. An example is shown in Figure 18.

Figure 17.  Utilities Menu, Petitions With Fee Payment

Figure 18.  Submit New Case With Fee Payment Dialog Box
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2. Click the Browse button.

The Select PDF document dialog box opens. An example of this dialog box is shown in 
Figure 19. By default, the Select PDF document dialog box points to the last location you 
accessed to attach documents from within ECF.

3. Navigate to and select the PDF file you want to attach.

4. Click the Open button.

The Select PDF document dialog box closes and ECF shows the file you selected, with the full 
path, in the Document field.

5. In the Description field for the document, type a description of the PDF.

Figure 19.  Select PDF document Dialog Box
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6. Repeat Step 2 - Step 5 for each PDF you want to attach to the submission.

Remember to include a certificate of service. An example with three PDF files to be submitted 
is shown in Figure 20.

7. Go to “To pay and complete the transaction” on page 40.

Figure 20.  Three PDF Files to be Submitted
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To pay and complete the transaction

1. Click the Pay Now and Submit button to submit your payment.

A new browser window or browser tab opens so that you can enter and submit your credit card 
information. The new browser window or tab may not automatically come to the front of your 
workspace. An example of a browser tab with the Step 1: Enter Payment Information page is 
shown in Figure 21.

CAUTION:  You are now connected to Pay.gov.

Figure 21.  Online Payment, Step 1
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2. Verify, change, and enter the information in the Step 1: Enter Payment Information page.

a. Verify and change the information in the Account Holder Name field and the billing 
address fields as needed.

CAUTION:  The name and address shown here are the name and address associated with 
your Appellate ECF account. If you are going to use a credit card that is not linked to the 
address we have on file for you, you must update the billing address.

b. Complete the Card Type, Card Number, Security Code and Expiration Date fields.

c. In the Attorney Name field, type the name of the attorney who logged in to Appellate ECF.

d. Complete the Contact Telephone Number and Person Completing Transaction fields so 
that the Court can contact you if there are any issues with the payment.

e. Click the Continue with Plastic Card Payment button.
The Step 2: Authorize Payment page opens. 

An example of a completed Step 1: Enter Payment Information page is shown in Figure 22.

Figure 22.  Online Payment, Step 1, Page Completed
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3. In the Step 2: Authorize Payment page, make sure all the payment information is correct and 
type your email address(es) in the Email Address, Confirm Email Address, and CC fields.

The email address(es) you enter here will receive a payment confirmation email when the 
transaction has been processed.

4. Select the checkbox under Authorization and Disclosure.

An example of a completed Step 2: Authorize Payment page is shown in Figure 23.

Figure 23.  Online Payment, Step 2, Page Completed
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5. Click the Submit Payment button.

CAUTION:  Wait for Pay.gov to process your payment. Do not click the button again.

When the transaction has completed, a confirmation page opens. An example is shown in 
Figure 24.

6. Click the Close Window button.

You can now return to Appellate ECF to log out or submit another petition or a filing.

7. To review what you just submitted, see “Reviewing Your Submissions” on page 48.

Figure 24.  Final Confirmation Page
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Submitting Electronic Versions of Original 
Petitions Without Fee Payment
Before you start, make sure you have all the PDF files ready to upload.

All attached documents must be searchable and must be accompanied by proof of service by mail 
or other method of service by the filer directly (no electronic service available through Appellate 
ECF). 

To submit electronic versions of original petitions without fee payment

1. In the Startup Page window, from the menu bar, choose Utilities > Submit New Case Without 
Fee Payment, then choose the appropriate option:

• Agency or Immigration Petition

• Petition for Writ of Mandamus

• 1292(b) Petition

• 1453(c) Petition

• 158(d) Petition

• 23(f) Petition

• Second or Successive Habeas Petition

An example of the Utilities menu with the options is shown in Figure 25.

Figure 25.  Utilities Menu, Petitions Without Fee Payment
44 -  ECF User Guide



Submitting Electronic Versions of Original Petitions >  Submitting Electronic Versions of Original Petitions Without Fee Payment
The Submit New Case Without Fee Payment dialog box opens. An example of the dialog box 
that opens for a new 1292(b) Petition is shown in Figure 26.

Figure 26.  Submit New Case With Fee Payment Dialog Box
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2. Click the Browse button.

The Select PDF document dialog box opens. An example of this dialog box is shown in 
Figure 27. By default, the Select PDF document dialog box points to the last location you 
accessed to attach documents from within ECF.

3. Navigate to and select the PDF file you want to attach.

4. Click the Open button.

The Select PDF document dialog box closes and ECF shows the file you selected, with the full 
path, in the Document field.

5. In the Description field for the document, type a description of the PDF.

Figure 27.  Select PDF document Dialog Box
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6. Repeat Step 3 - Step 5 for each PDF you want to submit.

Remember to include a certificate of service. An example with three PDF files to be submitted 
is shown in Figure 28.

7. Click the Submit button to upload the PDF files to the Court.

A message dialog box opens to confirm that you have completed the submission. An example 
is shown in Figure 29. 

8. Click the OK button.

The Submit New Case Without Fee Payment dialog box closes and you are returned to the 
Startup Page window.

9. To review what you just submitted, see “Reviewing Your Submissions” on page 48.

Figure 28.  Three PDF Files to be Submitted

Figure 29.  Submit New Case Without Fee Payment - Document(s) Submitted
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Reviewing Your Submissions
You can review a history of the original petitions you submitted and the payments you made.

To review your submissions
• In the Startup Page window, from the menu bar, choose Reports > History Report.

A new browser window or browser tab opens with the report. A sample report is shown in 
Figure 30.

This report shows a history of the PDF files you submitted using the functions in the Utilities 
menu and the payments you made through Pay.gov. This report does not show a history of 
filings or submissions you did in cases via the Filing menu, except fee payments.

Figure 30.  HIstory Report
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4 An Overview of Filing

The topics listed below describe the process of filing in ECF. In ECF, you use the Filing menu to 
start filing a document.

• “Completing an Electronic Filing” on page 50

• “Finding and Selecting the Filing Type” on page 57

• “Selecting the Filing Party” on page 58

• “Selecting Related Previous Entries for a Filing” on page 61

• “Selecting Reliefs for a Filing” on page 59

• “Checking a PDF File Before Filing” on page 63

• “Attaching PDF Documents to Filings” on page 65

• “Checking the Service List for a Case” on page 68
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Completing an Electronic Filing
You start the filing process by opening the File a Document window.

1. From the Filing menu, choose File a Document.

The File a Document window, shown in Figure 31, opens.

Figure 31.  File a Document Window
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2. In the Case field, type the number of the case for which you are entering the filing and press 
the Tab key.

Notice that the case number and title now appear below the menu bar in the File a Document 
window. In addition, the case number and title appear in the Case Selection box in the lower 
part of the window. The highlighted areas in Figure 32 indicate where the case information 
appears.

Figure 32.  File a Document Window With Case Information
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3. If other case numbers appear in the Case Selection box (another example is shown in 
Figure 33), make sure that you select the checkboxes for those additional cases where you want 
to enter your filing; this is in addition to the case that you entered in the Case field. 

You are now ready to find the filing type so you can enter your filing.

4. Use the information in “Finding and Selecting the Filing Type” on page 57 to make your 
selections to identify the type of filing you are entering.

5. Click the Continue button.

A warning dialog box opens. 

Figure 33.  Multiple Cases in Case Selection Box
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6. Carefully review the information in the dialog box, select the Continue checkbox, and click 
the OK button.

An example of a warning dialog box that opens when you submit a brief is shown in Figure 34.

A screen opens where you enter details about the filing. 

7. Use the information in the topics below to determine how to complete the different areas in the 
screen.

• “Selecting the Filing Party” on page 58

• “Selecting Reliefs for a Filing” on page 59

• “Selecting Related Previous Entries for a Filing” on page 61

• “Attaching PDF Documents to Filings” on page 65

• “Checking the Service List for a Case” on page 68

Figure 34.  Warning Dialog Box
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8. After you complete information in a details screen, click the Continue button.

If more information is needed for the filing, another details screen opens. In this case, fill in the 
necessary information and click the Continue button again.

When you have entered all the information for the filing, the Docket Text dialog box opens. An 
example of the Docket Text dialog box, for a response opposing a motion, is shown in 
Figure 35.

The Docket Text dialog box shows you the text of the entry as it will appear on the docket once 
you complete the filing. You cannot change the text in this dialog box. 

TIP:  If you realize that you need to make changes to the filing, you can click the Back button 
to step back in the filing.

9. Click the Continue button.

The Event Review dialog box opens. Even though the background of the window is white, you 
cannot change the text in this dialog box. An example of the Event Review dialog box is shown 
in Figure 36 on page 55.

Figure 35.  Docket Text Dialog Box
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TIP:  If you realize that you need to make changes to the filing, you can click the Back button 
to step back in the filing.

CAUTION:  This is the “point of no return.” 

10. Click the Submit button to confirm your filing.

The Event Docketed message dialog box, shown in Figure 37, opens. 

Figure 36.  Event Review Dialog Box

Figure 37.  Event Docketed Dialog Box
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11. Click the OK button.

A browser window opens with the notice of docket activity for your filing. An example of a 
browser window with a notice of docket activity is shown in Figure 38.

TIP:  If you are not seeing the notice in a new browser window or tab, check your pop-up 
blocker settings. You must allow pop-ups from the Court’s site.

This completes the filing process. 

Figure 38.  Notice of Docket Activity for Filing
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Finding and Selecting the Filing Type
The File a Document window has two areas that let you select the type of filing. Those areas are 
highlighted in Figure 39. 

This document refers to the area on the left as the categories list, and the area on the right as the 
filing types list. The filing types list is labeled Select One.

When you click a category in the categories list, a list of filing types appears in the area labeled 
Select One. 

For example, to file a motion, you would select the Motions/Responses/Replies radio button in 
the categories list, and then select the File a Motion in the filing types list.

Figure 39.  Filing Type
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Selecting the Filing Party
When you file a document, you will have to identify the parties that you represent in the appeal. If 
you are a pro se filer, you must identify yourself at this stage of the process. You identify the parties 
in the Party Filer area. The Party Filer area shows a list of all the parties in a case. If you are a 
pro se filer, your name will appear in this area.

Figure 40 shows an example of the Party Filer area without any selections. To select an entry, you 
must click the checkbox to the left of the Filer column. When a filer is selected, a checkmark 
appears in the checkbox and the row is highlighted. In Figure 41, the filer ABC Fiction Team is 
selected.

TIP:  You can use the Select All and Clear All buttons to select or clear all the entries in the list in 
the Party Filer area.

Filing Joint Documents
If you are filing a joint document on behalf of multiple parties, select all the parties who joined in 
the document.

Figure 40.  Party Filer Area - No Selections

Figure 41.  Party Filer Area - Selection Made
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Selecting Reliefs for a Filing
When you file a motion, you must select at least one relief. A relief describes your motion for the 
Court. You select reliefs in the Relief area. 

Figure 42 shows an example of the Relief area without any selections. 

To select a relief

1. From the Category drop-down list, select a category of reliefs.

Selecting a value from the Category drop-down list filters the values available in the 
Description drop-down list. An example of the Category drop-down list, in expanded state, is 
shown in Figure 43.

Figure 42.  Relief Area - No Selections

Figure 43.  Relief Area - Category Drop-Down List
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2. From the Description drop-down list, select a relief.

An example of the Description drop-down list, in expanded state, is shown in Figure 44.

3. Click the Apply button.

Your selection now appears in the Selected Reliefs list, as shown in Figure 45.

TIP:  You can use the Remove button to remove one selected entry, or the Clear All button to 
clear all the entries in the list.

4. To add another relief, repeat Step 1 - Step 3.

Figure 44.  Relief Area - Description Drop-Down List

Figure 45.  Relief Area - Relief Selected
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Selecting Related Previous Entries for a Filing
In some types of filings, such as responses, you may be required to select the entry to which your 
filing applies. You do this using the Related Previous Entries area.

Figure 46 shows an example of the Related Previous Entries area without any selections. You can 
click the document or lock icon in the Doc column to see the document that is attached to the entry 
on the Court’s docket. You may have to log in to PACER if you are not already logged in.
A lock icon instead of a document icon means that the document or documents attached to the filing 
are visible only to case participants.

To select a previous entry

1. In the list of entries, click the entry to which your filing applies.

The system highlights your selection. In Figure 47, the first entry in the list is highlighted.

Figure 46.  Related Previous Entries Area - No Selections

Figure 47.  Related Previous Entries Area - Entry Highlighted
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2. Click the Add button.

The system adds your selection to the Selected Entries list. An example is shown in Figure 48.

TIP:  You can use the Remove button to remove one selected entry, or the Clear All button to clear 
all the entries in the list.

Figure 48.  Related Previous Entries Area - Selected Entries List
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Checking a PDF File Before Filing
Appellate ECF lets you check your PDF file(s) to ensure they will be accepted by the system when 
you enter your filing.

To check a PDF file

1. From the Utilities menu, choose Check PDF Document.

The Select the file to inspect for PDF filing requirements dialog box opens. 
By default, this dialog box points to the last location you accessed to attach documents from 
within Appellate ECF.

2. Navigate to and select the PDF file you want to check.

3. Click the Open button.

The dialog box where you selected the PDF closes and the system runs the check in the 
background. When the check is complete, a message box opens with the results. 
If the file passes the check, you will see the message box show in Figure 49. Otherwise, you 
will see an error message. The two possible error messages are described below.

Error: File Too Large
If the file is too large, you will see an error message telling you that the document exceeds the 
maximum allowable size. In this case, you will have to split your PDF into parts that are not larger 
than the limit mentioned in the error message. This should only happen for scanned documents, not 
your main pleading. Your main pleading must be in searchable PDF created directly from your 
word processing application, not scanned.

Figure 49.  PDF Passed Check

Figure 50.  PDF is Too Large
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Error: File Contains Active Content
If the file has active content (a script or something else that may affect security in the Appellate 
ECF system), you will see the message shown in Figure 51. To fix this issue, you will have to 
optimize the PDF to remove any active content. Consult the documentation for the software you 
used to create the PDF file.

Figure 51.  PDF Contains Active Content
64 -  ECF User Guide



An Overview of Filing >  Attaching PDF Documents to Filings
Attaching PDF Documents to Filings
In ECF, you must always attach a PDF when you file a document. You attach documents to an 
event using the PDF Document area, shown in Figure 52.

CAUTION:  Each PDF that you attach to your filing may not exceed the current size limit (at the 
Startup Page window, click the Court Information link to see the current size limit). All your 
pleadings must be in searchable PDF format, per Circuit Rule 25-5.

To attach a document

1. In the PDF Document area, click the Browse button.

The Select PDF document dialog box opens. An example of this dialog box is shown in 
Figure 53. By default, the Select PDF document dialog box points to the last location you 
accessed to attach documents from within ECF.

2. Navigate to and select the PDF file you want to attach.

Figure 52.  PDF Document Area

Figure 53.  Select PDF document Dialog Box
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3. Click the Open button.

The Select PDF document dialog box closes and ECF shows the file you selected, with the full 
path, in the Document field. The default Description for the document is Main Document. 
An example is shown in Figure 54.

TIP:  You can click the View button to review the PDF and make sure you attached the correct 
document.

4. To attach another document, such as the certificate of service or a declaration in support of a 
motion, click the Add Another button.

NOTE:  The certificate of service does not need to be a separate document. The certificate of 
service can be part of the main document that you attach to the filing.

The PDF Document area expands to include another Document field, another Browse button, 
and a Description field for the second document, as shown in Figure 55. The default 
Description for each additional document is Additional Document.

5. Click the Browse button that was just added.

6. In the Select PDF document dialog box, navigate to and select the next PDF file you want to 
attach.

7. Click the OK button.

Figure 54.  PDF Document Area With One Document Selected for Upload

Figure 55.  PDF Document Area After Clicking Add Another
66 -  ECF User Guide



An Overview of Filing >  Attaching PDF Documents to Filings
8. In the Description field next to the file that you just added, change the default description or 
leave the default.

TIP:  If you attached a certificate of service, you could type Certificate of Service, 
as shown in the example in Figure 56.

9. To attach another document, return to Step 4 on page 66.

Figure 56.  PDF Document Area With Description Field Completed For Standard Form
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Checking the Service List for a Case
Before you file a document, make sure you review the service list for the case or cases so you know 
which attorneys or parties to serve by US Mail. You can check the service list for a case at any time.

TIP:  If you find that you cannot access the service list for a case, a pop-up blocker may be at work 
in your browser. The best way to check is to turn on the sound on your system, then try to access 
the Service List (Reports > Service List) or the Help (Help > Help), you should hear a distinctive 
“ding” which indicates that there is something blocking a web page from opening. Make sure you 
change the pop-up blocker settings to allow all pop-ups from our site.

To check the service list for a case

1. From the Reports menu, choose Service List.

A new browser window opens. An example of what appears in the page is shown in Figure 57.

2. In the Case Number field, type the case number.

NOTE:  The Include Associated Cases checkbox is selected by default. If you do not want to 
include associated cases, clear the checkbox.

Figure 57.  Request Service List Page
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3. Click the Show Service List button.

The service list for the case is shown in the browser window. An example of the report is shown 
in Figure 58.

CAUTION:  If you try to see the service for a sealed case, the system will tell you that it cannot 
find the case.

• If the word Active is in the ECF Filing Status column, then your electronic filing will 
constitute service to the party.

• If Not Registered, Exempt, Pending, Rejected, or Suspended is in the ECF Filing Status 
column (or the column is blank), then you must serve this party by US Mail.

Figure 58.  Service List for a Case
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Fee for an Original 
Petition

After an original petition (such as petitions for review or petitions for writ of mandamus) has been 
opened in the Court and you have a case number, you can pay the $450.00 filing fee using 
Appellate ECF and your credit card.

CAUTION:  Before you start, you must ensure that there are no pop-up blockers that prevent you 
from seeing the payment page. The payment window from Pay.gov opens in a new browser 
window or browser tab. 
The easiest way to check is to turn on the sound on your system, then try to access the Service List 
(Reports > Service List). If you hear a distinctive “ding,” you know that something is blocking the 
web page from opening. Make sure you change the pop-up blocker settings to allow all pop-ups 
from the Court’s site.

To pay the case opening fee for an original petition

1. In the Startup Page window, from the menu bar, choose Filing > File a Document.

The File a Document window opens. For a description of the File a Document window, see 
“Finding and Selecting the Filing Type” on page 57.

2. In the upper part of the window, in the Case field, type the case number and press the Tab key.

TIP:  Notice that the case number and title now appear below the menu bar in the File a 
Document window. In addition, the case number and title appear in the Case Selection box in 
the lower part of the window. The Case Selection box also lists all other cases associated to the 
case for which you entered the case number in the Case field. 

3. In the categories list, select the Pay Case Opening Fees radio button.

The right part of the window is updated to show the only filing type available in this category: 
Pay Fee for Agency Petition/Petition for Writ of Mandamus.
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4. Click the Continue button.

A dialog box opens to remind you that if you filed a notice of appeal in another court, you must 
pay the filing and appeal fees in that court. An example of that dialog box is shown in 
Figure 59.

5. Carefully review the message and when you are done, select the Continue checkbox button at 
the bottom of the dialog box and then click the OK button.

A screen opens where you must enter additional information about the payment that you are 
about to submit.

6. In the Party Filer area, select the party or parties you represent by selecting the checkbox to 
the left of the Filer column.

NOTE:  If you are a Pro Se filer, select your name in the list.

Figure 59.  Submit Brief for Review by the Court - Warning Dialog Box
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7. Click the Pay Now button.

A new browser window or browser tab opens so that you can enter and submit your credit card 
information. The new browser window or tab may not automatically come to the front of your 
workspace. An example of a browser tab with the Step 1: Enter Payment Information page is 
shown in Figure 60.

CAUTION:  You are now connected to Pay.gov.

Figure 60.  Online Payment, Step 1
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8. Verify, change, and enter the information in the Step 1: Enter Payment Information page.

a. Verify and change the information in the Account Holder Name field and the billing 
address fields as needed.

CAUTION:  The name and address shown here are the name and address associated with 
your Appellate ECF account. If you are going to use a credit card that is not linked to the 
address we have on file for you, you must update the billing address.

b. Complete the Card Type, Card Number, Security Code and Expiration Date fields.

c. In the Attorney Name field, type the name of the attorney who logged in to ECF.

d. Complete the Contact Telephone Number and Person Completing Transaction fields so 
that the Court can contact you if there are any issues with the payment.

e. Click the Continue with Plastic Card Payment button.
The Step 2: Authorize Payment page opens. 

An example of a completed Step 1: Enter Payment Information page is shown in Figure 61.

Figure 61.  Online Payment, Step 1, Page Completed
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9. In the Step 2: Authorize Payment page, make sure all the payment information is correct and 
type your email address(es) in the Email Address, Confirm Email Address, and CC fields.

The email address(es) you enter here will receive a payment confirmation email when the 
transaction has been processed.

10. Select the checkbox under Authorization and Disclosure.

An example of a completed Step 2: Authorize Payment page is shown in Figure 62.

Figure 62.  Online Payment, Step 2, Page Completed
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11. Click the Submit Payment button.

CAUTION:  Wait for Pay.gov to process your payment. Do not click the button again.

When the transaction has completed, a confirmation page opens. An example is shown in 
Figure 63.

CAUTION:  Do not close the browser window at this point. Your transaction will not be 
committed into Appellate ECF.

12. Click the Return to CM/ECF button.

Figure 63.  Final Confirmation Page
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13. Return to the window titled Filing Pay Fee for Agency Petition/Petition for Writ of Mandamus 
window. This is the window where you clicked the Pay Now button to submit your payment.

An example is shown in Figure 64. Notice that the Pay Now button is no longer enabled 
because you completed the payment.

Figure 64.  Filing Window, Payment Completed
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14. Click the Continue button at the bottom of the screen.

The Docket Text dialog box, shown in Figure 65, opens. This dialog box shows you the text of 
the entry as it will appear on the docket once you complete the filing. You cannot change the 
text in this dialog box. 

15. Click the Continue button.

The Event Review dialog box, shown in Figure 66, opens. Even though the background of the 
window is white, you cannot change the text in this dialog box.

CAUTION:  This is the “point of no return.” If you made a mistake, click the Back button to step 
back in the filing.

16. Click the Submit button to confirm your filing and the payment.

The Event Docketed message dialog box opens.

Figure 65.  Submit Brief for Review by the Court - Docket Text Dialog Box

Figure 66.  Submit Brief for Review by the Court - Event Review Dialog Box
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17. Click the OK button.

A browser window or tab opens with the notice of docket activity for your filing.

NOTE:  If a browser window or browser tab does not open with the notice of docket activity, 
check the pop-up blocker settings in your browser. The only reason the notice of docket activity 
does not open is that a pop-up blocker is preventing a window or tab from opening.

18. To review a report of the payments you made, see “Reviewing Your Submissions” on page 48.
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Review by the Court

Before you start, make sure you review the information in “An Overview of Filing” on page 49, to 
familiarize yourself with the process of filing something in ECF.

Follow the instructions in this topic to submit a brief (optionally including excerpts of record) for 
review by the Court.

1. In the Startup Page window, from the menu bar, choose Filing > File a Document.

The File a Document window opens. For a description of the File a Document window, see 
“Finding and Selecting the Filing Type” on page 57.

2. In the upper part of the window, in the Case field, type the case number and press the Tab key.

TIP:  Notice that the case number and title now appear below the menu bar in the File a 
Document window. In addition, the case number and title appear in the Case Selection box in 
the lower part of the window. The Case Selection box also lists all other cases associated to the 
case for which you entered the case number in the Case field. 

3. In the categories list, select the Briefs radio button.

The right part of the window is updated to show a list of possible filings in the Briefs category.

4. In the list labeled Select One, select the Submit Brief for Review by the Court radio button.
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5. (Optional) If other case numbers appear in the Case Selection box (an example is shown in 
Figure 67), make sure that you select the checkboxes for those additional cases where you want 
to enter your filing; this is in addition to the case that you entered in the Case field. 

NOTE:  No matter what type of association is shown in parentheses next to the additional cases, 
if a case is selected, the filing will be done in the case.

Figure 67.  Multiple Cases in Case Selection Box
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6. Click the Continue button.

A dialog box opens with a number of warnings. An example of that dialog box is shown in 
Figure 68.

7. Carefully review each message and when you are done, select the Continue checkbox button 
at the bottom of the dialog box to confirm that you have read the messages.

CAUTION:  If you read a warning and realize that you need to edit your brief, then do not 
continue with this event. In this case, click the OK button without selecting the Continue 
checkbox.

Figure 69 on page 82 shows an example of the warning dialog box with the Continue 
checkbox selected.

Figure 68.  Submit Brief for Review by the Court - Warning Dialog Box
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TIP:  If you do not see all the messages or the OK button, check your screen settings and make 
sure you are running at a screen resolution of at least 1024 x 768 pixels.

8. When you have reviewed all the warnings and selected the Continue checkbox, click the OK 
button.

A screen opens where you must enter additional information about the brief (and optionally, 
the excerpts of record) that you are submitting.

Figure 69.  Submit Brief for Review by the Court - Warning Dialog Box - Ready to Continue
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9. In the Party Filer area, select the party or parties you represent by selecting the checkbox to 
the left of the Filer column.

Figure 70 shows an example of a Party Filer area with the Appellant party selected.

NOTE:  If you are a Pro Se filer, select your name in the list.

See “Selecting the Filing Party” on page 58 for step-by-step instructions.

Figure 70.  Submit Brief for Review by the Court - Party Filer

o
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10. In the Service Date field, type the date of service.

TIP:  Remember to review the service list for the case by choosing Reports > Service List. 
Follow the step-by-step instructions in “Checking the Service List for a Case” on page 68.

11. From the Type of Brief drop-down list, select the correct value.

CAUTION:  This drop-down list defaults to Please Select. You must select another value 
from the drop-down list.

At this point, the screen should look similar to what is shown in Figure 71.

12. Use the first PDF Document area (the one below the Type of Brief drop-down list) to attach 
your brief.

CAUTION:  Your entire brief should be submitted as one PDF file, including all certificates.

See “Attaching PDF Documents to Filings” on page 65 for step-by-step instructions.

TIP:  To make sure that you attached the correct PDF file, you can click the View button to 
review the PDF.

13. If you are not attaching excerpts of record, go to Step 16 on page 86.

Figure 71.  Submit Brief for Review by the Court - Party Filer, Service Date and Type of Brief Completed
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14. If you are attaching excerpts of record, select the correct type from the Type Of Excerpts Of 
Record drop-down list:

• excerpts of record 

• supplemental excerpts of record 

• further excerpts of record 

15. Use the second PDF Document area (the one below the Type Of Excerpts Of Record 
drop-down list) to attach the excerpts of record PDF files. 

For each PDF file, type a description that accurately describes the content of the file. After you 
have attached all the PDF documents, the lower part of the screen should look similar to what 
is shown in Figure 72. 

Figure 72.  Submit Brief for Review by the Court - Second Page Completed
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16. Click the Continue button at the bottom of the screen.

The Docket Text dialog box, shown in Figure 73, opens. This dialog box shows you the text of 
the entry as it will appear on the docket once you complete the filing. You cannot change the 
text in this dialog box. The example below shows an example for a submission that includes a 
brief and excerpts of record.

17. Click the Continue button.

The Event Review dialog box, shown in Figure 74, opens. Even though the background of the 
window is white, you cannot change the text in this dialog box.

CAUTION:  This is the “point of no return.” If you made a mistake, click the Back button to step 
back in the filing.

18. Click the Submit button to confirm your filing.

The Event Docketed message dialog box opens.

Figure 73.  Submit Brief for Review by the Court - Docket Text Dialog Box

Figure 74.  Submit Brief for Review by the Court - Event Review Dialog Box
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19. Click the OK button.

A browser window or tab opens with the notice of docket activity for your filing.

NOTE:  If a browser window or browser tab does not open with the notice of docket activity, 
check the pop-up blocker settings in your browser. The only reason the notice of docket activity 
does not open is that a pop-up blocker is preventing a window or tab from opening.
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Before you start, make sure you review the information in “An Overview of Filing” on page 49, to 
familiarize yourself with the process of filing something in ECF.

Follow the instructions in this topic to file a motion.

1. In the Startup Page window, from the menu bar, choose Filing > File a Document.

The File a Document window opens. For a description of the File a Document window, see 
“Finding and Selecting the Filing Type” on page 57.

2. In the upper part of the window, in the Case field, type the case number and press the Tab key.

TIP:  Notice that the case number and title now appear below the menu bar in the File a 
Document window. In addition, the case number and title appear in the Case Selection box in 
the lower part of the window. The Case Selection box also lists all other cases associated to the 
case for which you entered the case number in the Case field.

3. In the categories list, select the Motions/Responses/Replies radio button.

The right part of the window is updated to show a list of possible filings in the Motions/
Responses/Replies category.

4. In the list labeled Select One, select the File a Motion radio button.
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5. (Optional) If other case numbers appear in the Case Selection box (an example is shown in 
Figure 75), make sure that you select the checkboxes for those additional cases where you want 
to enter your filing; this is in addition to the case that you entered in the Case field. 

NOTE:  No matter what type of association is shown in parentheses next to the additional cases, 
if a case is selected, the filing will be done in the case.

6. Click the Continue button.

A dialog box opens with a number of messages. An example of that dialog box is shown in 
Figure 76.

7. Carefully review each message and when you are done, select the Continue checkbox button 
at the bottom of the dialog box to confirm that you have read the messages.

Figure 75.  Multiple Cases in Case Selection Box

Figure 76.  File a Motion - Warning Dialog Box
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8. Click the OK button.

A screen opens where you must enter additional information about the filing. The screen has 
the following areas: Party Filer, Additional Information, NOTE, nand Relief.

9. In the Party Filer area, select the party or parties you represent by selecting the checkbox to 
the left of the Filer column.

NOTE:  If you are a Pro Se filer, select your name in the list.

Figure 77 shows an example of a Party Filer area with the Respondent party selected. See 
“Selecting the Filing Party” on page 58 for step-by-step instructions.

10. If this is not a standard motion, select a value from the Optional Modifier For Motion 
drop-down list.

Figure 77.  File a Motion - Party Filer

o
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11. In the Relief area, select the relief that describes the motion by doing the following:

a. From the Description drop-down list, select the relief.

b. Click the Apply button.

c. Repeat Step a and Step b to add another relief.

Figure 78 shows an example of a Relief area with two reliefs selected: motion for attorney 
fees and motion for miscellaneous relief. 

See “Selecting Reliefs for a Filing” on page 59 for detailed instructions.

12. Click the Continue button.

Figure 78.  File a Motion - Relief Selected

o
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13. If you selected motion for miscellaneous relief, a Relief Preconditions dialog box opens. In 
this case, if you are sure there is no relief that matches your request, click the Continue 
checkbox, then click the OK button to continue.

Figure 79 shows an example of a Relief Preconditions dialog box.

Another screen opens where you must enter more information about the filing.

14. In the Service Date field, type the date of service.

TIP:  Remember to review the service list for the case by choosing Reports > Service List. 
Follow the step-by-step instructions in “Checking the Service List for a Case” on page 68.

Figure 79.  Relief Preconditions Dialog Box

o
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15. Use the PDF Document area to attach your pleading and any other documents that you want 
to submit to the Court.

See “Attaching PDF Documents to Filings” on page 65 for step-by-step instructions.

After you have attached all the PDF documents, the screen should look similar to what is shown 
in Figure 80.

NOTE:  Depending on the relief or reliefs that you selected on the previous page, other 
Additional Information areas with additional fields may appear on the screen, such as 
Amount of Attorney Fees Requested, or Description of Miscellaneous Motion. If this 
happens, make sure you fill in those fields before continuing to the next step.

Figure 80.  File a Motion - Second Page Completed
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16. Click the Continue button at the bottom of the screen.

The Docket Text dialog box, shown in Figure 81, opens. This dialog box shows you the text of 
the entry as it will appear on the docket once you complete the filing. You cannot change the 
text in this dialog box. 

17. Click the Continue button.

The Event Review dialog box, shown in Figure 82, opens. Even though the background of the 
window is white, you cannot change the text in this dialog box.

CAUTION:  This is the “point of no return.” If you made a mistake, click the Back button to step 
back in the filing.

18. Click the Submit button to confirm your filing.

The Event Docketed message dialog box opens.

Figure 81.  File a Motion - Docket Text Dialog Box

Figure 82.  File a Motion - Event Review Dialog Box
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19. Click the OK button.

A browser window opens with the notice of docket activity for your filing.

NOTE:  If a browser window or browser tab does not open with the notice of docket activity, 
check the pop-up blocker settings in your browser. The only reason the notice of docket activity 
does not open is that a pop-up blocker is preventing a window or tab from opening.
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8 Filing a Motion and a 
Response to a Motion 
Together

Before you start, make sure you review the information in “An Overview of Filing” on page 49, to 
familiarize yourself with the process of filing something in ECF.

Follow the instructions in this topic to file a motion and a response to a motion in one filing (and 
one document).

1. In the Startup Page window, from the menu bar, choose Filing > File a Document.

The File a Document window opens. For a description of the File a Document window, see 
“Finding and Selecting the Filing Type” on page 57.

2. In the upper part of the window, in the Case field, type the case number and press the Tab key.

TIP:  Notice that the case number and title now appear below the menu bar in the File a 
Document window. In addition, the case number and title appear in the Case Selection box in 
the lower part of the window.

3. In the categories list, select the Motions/Responses/Replies radio button.

The right part of the window is updated to show a list of possible filings in the Motions/
Responses/Replies category.

4. In the list labeled Select One, select the File a Motion and a Response to a Motion Together 
radio button.
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5. If other case numbers appear in the Case Selection box (an example is shown in Figure 83), 
make sure that you select the checkboxes for those additional cases where you want to enter 
your filing; this is in addition to the case that you entered in the Case field. 

NOTE:  No matter what type of association is shown in parentheses next to the additional cases, 
if a case is selected, the filing will be done in the case.

6. Click the Continue button.

A dialog box opens with a number of messages. An example of that dialog box is shown in 
Figure 84.

7. Carefully review the messages and when you are done, select the Continue checkbox button 
at the bottom of the dialog box to confirm that you have read the messages.

Figure 83.  Multiple Cases in Case Selection Box

Figure 84.  File a Motion and a Response to a Motion Together- Warning Dialog Box
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8. Click the OK button.

A screen opens where you must enter additional information about the filing.

9. In the Party Filer area, select the party or parties you represent by selecting the checkbox to 
the left of the Filer column.

NOTE:  If you are a Pro Se filer, select your name in the list.

Figure 85 shows an example of a Party Filer area with the Respondent party selected. See 
“Selecting the Filing Party” on page 58 for step-by-step instructions.

10. If this is not a standard motion, select a value from the Optional Modifier For Motion 
drop-down list.

Figure 85.  File a Motion and a Response to a Motion Together - Party Filer

o
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11. In the Relief area, select the relief that describes the motion by doing the following:

a. From the Description drop-down list, select the relief.

b. Click the Apply button.

c. Repeat Step a and Step b to add another relief.

Figure 86 shows an example of a Relief area with two reliefs selected: motion for attorney 
fees and motion for miscellaneous relief. 

See “Selecting Reliefs for a Filing” on page 59 for detailed instructions.

12. Click the Continue button.

Figure 86.  File a Motion and a Response to a Motion Together - Relief Selected

o

ECF User Guide -  99



Filing a Motion and a Response to a Motion Together >  
13. If you selected motion for miscellaneous relief, a Relief Preconditions dialog box opens. In 
this case, if you are sure there is no relief that matches your request, click the Continue 
checkbox, then click the OK button to continue.

Figure 87 shows an example of a Relief Preconditions dialog box.

A screen opens with two areas: Additional Information and Related Previous Entries. An 
example is shown in Figure 88.

14. From the Optional Response Type drop-down list, select the value that matches the type of 
response you are filing.

Figure 87.  Relief Preconditions Dialog Box

o

Figure 88.  Additional Information and Related Previous Entries Areas
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15. Use the controls in the Related Previous Entries area to select the motion for which you are 
filing a response.

See “Selecting Related Previous Entries for a Filing” on page 61 for step-by-step instructions 
for selecting the previous filing for which you are filing a response.

16. Click the Continue button.

Another screen opens where you must enter more information about the filing.

17. In the Service Date field, type the date of service.

TIP:  Remember to review the service list for the case by choosing Reports > Service List. 
Follow the step-by-step instructions in “Checking the Service List for a Case” on page 68.

18. Use the PDF Document area to attach your pleading and any other documents that you want 
to submit to the Court.

See “Attaching PDF Documents to Filings” on page 65 for step-by-step instructions.

19. Click the Continue button at the bottom of the screen.

NOTE:  Depending on the relief or reliefs that you selected for your motion, other Additional 
Information areas with additional fields may appear on the screen, such as Amount of 
Attorney Fees Requested, or Description of Miscellaneous Motion. If this happens, make 
sure you fill in those fields before clicking the Continue button again.

The Docket Text dialog box opens. This dialog box shows you the text of the entry as it will 
appear on the docket once you complete the filing. You cannot change the text in this dialog 
box. 

20. Click the Continue button.

The Event Review dialog box opens. Even though the background of the window is white, you 
cannot change the text in this dialog box.

CAUTION:  This is the “point of no return.” If you made a mistake, click the Back button to step 
back in the filing.

21. Click the Submit button to confirm your filing.

The Event Docketed message dialog box opens.

22. Click the OK button.

A browser window or tab opens with the notice of docket activity for your filing.
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9 Filing a Court Reporter 
Motion to Extend Time

Before you start, make sure you review the information in “An Overview of Filing” on page 49, to 
familiarize yourself with the process of filing something in ECF.

Follow the instructions in this topic to file a court reporter motion to extend time.

TIP:  The Court has prepared a fill-in form that you can use for your motions. Check the Court’s 
Forms section in the ECF page at http:/www.ca9.uscourts.gov/cmecf.

1. In the Startup Page window, from the menu bar, choose Filing > File a Document.

The File a Document window opens. For a description of the File a Document window, see 
“Finding and Selecting the Filing Type” on page 57.

2. In the upper part of the window, in the Case field, type the case number and press the Tab key.

TIP:  Notice that the case number and title now appear below the menu bar in the File a 
Document window. In addition, the case number and title appear in the Case Selection box in 
the lower part of the window.

3. In the categories list, select the Court Reporters radio button.

The right part of the window is updated to show a list of possible filings in the 
Court Reporters category.

4. In the list labeled Select One, select the File a Court Reporter Motion to Extend Time radio 
button.
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5. (Optional) If other case numbers appear in the Case Selection box (an example is shown in 
Figure 89), make sure that you select the checkboxes for those additional cases where you want 
to enter your filing; this is in addition to the case that you entered in the Case field. 

NOTE:  No matter what type of association is shown in parentheses next to the additional cases, 
if a case is selected, the filing will be done in the case.

6. Click the Continue button.

A dialog box opens with a number of messages. An example of that dialog box is shown in 
Figure 90.

7. Carefully review each message and when you are done, select the Continue checkbox button 
at the bottom of the dialog box to confirm that you have read the messages.

Figure 89.  Multiple Cases in Case Selection Box

Figure 90.  File a Court Reporter Motion to Extend Time - Warning Dialog Box
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8. Click the OK button.

A screen opens where you must enter additional information about the filing. An example of 
the screen is shown in Figure 91.

9. Do one of the following:

• If your name appears in the Court Reporter Filer area, select your name by selecting the 
checkbox to the left of the Filer column.

-or-

• If your name does not appear in the Court Reporter Filer area, type it in the text box in 
the Additional Information area.

10. Click the Continue button.

Another screen opens where you must enter more information about the filing.

11. In the Service Date field, type the date of service.

TIP:  Remember to review the service list for the case by choosing Reports > Service List. 
Follow the step-by-step instructions in “Checking the Service List for a Case” on page 68.

12. Use the PDF Document area to attach your pleading and any other documents that you want 
to submit to the Court.

See “Attaching PDF Documents to Filings” on page 65 for step-by-step instructions.

TIP:  The Court has prepared a fill-in form that you can use for your motions. Check the Court’s 
Forms section in the ECF page at http:/www.ca9.uscourts.gov/cmecf.

Figure 91.  Identifying the Court Reporter Filer
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13. Click the Continue button at the bottom of the screen.

The Docket Text dialog box, shown in Figure 92, opens. This dialog box shows you the text of 
the entry as it will appear on the docket once you complete the filing. You cannot change the 
text in this dialog box. 

14. Click the Continue button.

The Event Review dialog box, shown in Figure 93, opens. Even though the background of the 
window is white, you cannot change the text in this dialog box.

CAUTION:  This is the “point of no return.” If you made a mistake, click the Back button to step 
back in the filing.

15. Click the Submit button to confirm your filing.

The Event Docketed message dialog box opens.

16. Click the OK button.

A browser window or tab opens with the notice of docket activity for your filing.

NOTE:  If a browser window or browser tab does not open with the notice of docket activity, 
check the pop-up blocker settings in your browser. The only reason the notice of docket activity 
does not open is that a pop-up blocker is preventing a window or tab from opening.

Figure 92.  File a Court Reporter Motion to Extend Time - Docket Text Dialog Box

Figure 93.  File a Court Reporter Motion to Extend Time - Event Review Dialog Box
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10 Filing a Petition for 
Rehearing

Before you start, make sure you review the information in “An Overview of Filing” on page 49, to 
familiarize yourself with the process of filing something in ECF.

Follow the instructions in this topic to request rehearing of an Opinion or a Memorandum 
Disposition.

The instructions in this topic apply to the following types of filings:

• Petition for Panel Rehearing (FRAP 40; 9th Cir. R. 40-1)

• Petition for Rehearing En Banc (FRAP 35; 9th Cir. R. 35-1)

• Combination Petition for Panel Rehearing/En Banc (FRAP 35, 40)

CAUTION:  If you want to request reconsideration of an Order, file a motion for reconsideration 
instead.

1. Make sure you have a PDF copy of the Opinion or Memorandum Disposition for which you 
are requesting the rehearing. 

You must attach the Opinion or Memorandum Disposition to your filing.

2. In the Startup Page window, from the menu bar, choose Filing > File a Document.

The File a Document window opens. For a description of the File a Document window, see 
“Finding and Selecting the Filing Type” on page 57.

3. In the upper part of the window, in the Case field, type the case number and press the Tab key.

TIP:  Notice that the case number and title now appear below the menu bar in the File a 
Document window. In addition, the case number and title appear in the Case Selection box in 
the lower part of the window. The Case Selection box also lists all other cases associated to the 
case for which you entered the case number in the Case field. 

4. In the categories list on the left, select the Rehearing/Reconsideration radio button.

The right part of the window is updated to show a list of possible filings in the Rehearing/
Reconsideration category.
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5. In the list labeled Select One, do one of the following:

• To request a rehearing by panel only, select the File a Petition for Panel Rehearing 
(FRAP 40; 9th Cir. R. 40-1) radio button.

• To request a rehearing by en banc panel only, select the File a Petition for Rehearing En 
Banc (FRAP 35; 9th Cir. R. 35-1) radio button.

• To request a rehearing by panel and en banc panel, select the File a Combination Petition 
for Panel Rehearing/En Banc (FRAP 35, 40)Submit Brief for Review by the Court 
radio button.

Figure 94 shows an example of the File a Document window with the filing category 
Rehearing/Reconsideration and available rehearing types highlighted.

Figure 94.  File a Document Window With Filing Category and Types Highlighted
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6. (Optional) If other case numbers appear in the Case Selection box (an example is shown in 
Figure 95), make sure that you select the checkboxes for those additional cases where you want 
to enter your filing; this is in addition to the case that you entered in the Case field. 

NOTE:  No matter what type of association is shown in parentheses next to the additional cases, 
if a case is selected, the filing will be done in the case.

7. Click the Continue button.

A dialog box opens with a number of messages. An example of that dialog box is shown in 
Figure 96.

Figure 95.  Multiple Cases in Case Selection Box

Figure 96.  File a Petition for Panel Rehearing - Warning Dialog Box
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8. Carefully review each message and when you are done, select the Continue checkbox button 
at the bottom of the dialog box to confirm that you have read the messages.

CAUTION:  If you want to request reconsideration of an Order, click the OK button to return to 
the previous screen, and select File a Motion for Reconsideration instead.

9. Click the OK button.

A screen opens where you must enter additional information about the rehearing request that 
you are filing.

10. In the Party Filer area, select the party or parties you represent by selecting the checkbox to 
the left of the Filer column.

NOTE:  If you are a Pro Se filer, select your name in the list.

See “Selecting the Filing Party” on page 58 for step-by-step instructions.

11. From the Requesting Rehearing of drop-down list, select the correct value.

CAUTION:  This drop-down list defaults to memorandum. Make sure you select opinion if 
you are requesting a rehearing of an opinion.

12. In the Date of Memorandum or Opinion field, type the date the memorandum or opinion was 
filed.

13. In the Service Date field, type the date of service.

TIP:  Remember to review the service list for the case by choosing Reports > Service List. 
Follow the step-by-step instructions in “Checking the Service List for a Case” on page 68.
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14. Use the PDF Document area to attach your pleading and any other documents that you want 
to submit to the Court.

See “Attaching PDF Documents to Filings” on page 65 for step-by-step instructions.

You are required to a copy of the opinion or memorandum disposition being challenged, 
otherwise your petition will be rejected. See 9th Cir. R. 40-1(c).

At this point, the screen should look similar to what is shown in Figure 97.

Figure 97.  File a Petition for Rehearing- Second Page Completed
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15. Click the Continue button at the bottom of the screen.

The Docket Text dialog box, shown in Figure 98, opens. This dialog box shows you the text of 
the entry as it will appear on the docket once you complete the filing. You cannot change the 
text in this dialog box. 

16. Click the Continue button.

The Event Review dialog box, shown in Figure 99, opens. Even though the background of the 
window is white, you cannot change the text in this dialog box.

CAUTION:  This is the “point of no return.” If you made a mistake, click the Back button to step 
back in the filing.

17. Click the Submit button to confirm your filing.

The Event Docketed message dialog box opens.

Figure 98.  File a Petition for Panel Rehearing - Docket Text Dialog Box

Figure 99.  File a Petition for Panel Rehearing - Event Review Dialog Box
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18. Click the OK button.

A browser window or tab opens with the notice of docket activity for your filing.

NOTE:  If a browser window or browser tab does not open with the notice of docket activity, 
check the pop-up blocker settings in your browser. The only reason the notice of docket activity 
does not open is that a pop-up blocker is preventing a window or tab from opening.
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11 Working With Email 
Notices of Docket 
Activity

The topics below describe the notice of docket activity and explain how to save a copy of the 
documents attached to the notice.

• “What is in a Notice of Docket Activity?” on page 114

• “The Subject Line of a Notice of Docket Activity” on page 115

• “Document Links in a Notice of Docket Activity” on page 116
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What is in a Notice of Docket Activity?
A notice of docket activity is a notice that is generated whenever something is entered on the docket 
of a case. The top of the notice contains a disclaimer stating that public users may view the notice 
information once free of charge (“one free look”). After that, a fee will be assessed.

NOTE:  If you are not a party or attorney in a case, and you signed up to receive notices for cases 
of interest, the “one free look” does not apply. 

The notice shows case information, docket text, the recipient names, and a hyperlink for the case 
number. In addition, the notice may include a link labeled Document(s). If you are logged in to 
PACER, clicking the case number hyperlink takes you to the Docket Report window from where 
you can generate a docket report. “Document Links in a Notice of Docket Activity” on page 116 
explains how the document links work. 

An example of a browser window with a notice of docket activity is shown in Figure 100.

Figure 100.  Notice of Docket Activity for Filing
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The Subject Line of a Notice of Docket Activity
The subject line of a notice of docket activity shows the case number, the case title, and provides 
a short description of the activity that happened in the case.

Even if the notice applies to several cases, the subject line of a notice of docket activity only lists 
one case number! An example of this is a notice of oral argument. Usually, a notice of oral 
argument notice applies to all the cases that are scheduled to be heard on the same day, but only 
one case number will appear in the subject line of the notice of docket activity. The docket text 
includes information to let you know that you must open the documents attached to the notice to 
view details about your case. An example of docket text for a notice of oral argument is shown 
below.

Notice of Oral Argument on AUGUST Calendar. Please return 
ACKNOWLEDGEMENT OF HEARING NOTICE form to: SEATTLE Office. 
Attention: The Notice of Docket Activity may not list your case 
number. Please open attached documents to view details about 
your case. [07-30344, 07-30452, 07-30458, 07-30459, 07-35188, 
07-35341, 07-35610, 07-35841, 07-35907] 
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Document Links in a Notice of Docket Activity
A Document(s) link appears in the notice if one or more documents were attached to the activity 
in the docket.

You can click the Document(s) link to view the document or documents that were attached.

CAUTION:  Remote electronic access to documents in Social Security cases and immigration 
matters is limited to the attorneys or parties in the case in order to protect the privacy of the 
individuals involved in those cases. You may inspect these files in person in the Clerk's office. If 
you are a party or attorney in the case, you can access documents in these cases only by using your 
Appellate ECF Filer ID and Password and choosing Reports > PACER Report after you have 
logged in to Appellate ECF. See Federal Rule of Appellate Procedure 25(a)(5) and Federal Rule 
of Civil Procedure 5.2.

In ECF documents are attached in portable document format (PDF). This means that when you 
click a document link, the document opens in Adobe Reader or in another PDF-capable application 
on your system. For the purpose of this guide, we will assume that you are using Adobe Reader.

NOTE:  If you are not a party or attorney in a case, and you signed up to receive notices for cases 
of interest, the “one free look” does not apply. 

To save a copy of a document attached to a notice of docket activity

1. In the notice of docket activity, click the Document(s) link.

NOTE:  If more than one document is attached to the entry, a page opens with a number of links. 
There is one link for each attached document. In this case, click the link of the document that 
you want to open.

The document opens in your web browser or in a separate Adobe Reader window, depending 
on your settings. 

2. Choose File > Save As (or Save A Copy, if Save As is not shown). 

-or-

Click the Save a Copy button in the toolbar.

3. In the Save As dialog box, enter the file name and location, and click the Save button. 
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12 Creating 
Cross-Document 
Hyperlinks

The topics below describe how to create a hyperlink in a PDF document, where the hyperlink links 
to another PDF document in a CM/ECF database. The document being referenced can be a 
document that was previously filed or a document that is being filed in the same transaction (filing) 
as the referencing document. The steps to create a hyperlink and to generate documents in PDF 
format are similar whether you are using WordPerfect or Word to create documents; differences are 
noted as needed.

CAUTION:  Keep in mind that if you create hyperlinks in your pleadings, and those hyperlinks take 
the reader to another document on PACER, anyone viewing your filing will have to pay the 
standard PACER fees when accessing those other documents.

• “Creating a Hyperlink to a Document Already Filed in a Case” on page 118

• “Creating Hyperlinks Between Documents in the Same Filing” on page 122
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Creating a Hyperlink to a Document Already 
Filed in a Case
You can create a link to another document in any database in the Federal Courts: District, 
Bankruptcy (as of December 2006) or Appellate (as of July 2006, Version 1.3).

1. Access CM/ECF and run the docket report for the case in which the document was filed.

2. Locate the document among the docket entries.

3. Copy the URL (the “address”) of the document to the clipboard by doing the following:

a. Hover over the document link and click the right mouse button (the document link displays 
after the docket date and is represented by an icon or a number with an underscore, for 
example, 5).

b. From the pop-up menu, choose Copy Shortcut, Copy Link Location, or Copy Link 
Address (the option you will see depends on your browser),

CAUTION:  DO NOT copy the URL from the browser’s address bar when the document is 
open.

An example of the pop-up menu in Firefox is shown in Figure 101.

4. Open the word processing document.

Figure 101.  Pop-up Menu for Document in Docket Report
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5. In the document, highlight the citation text for which you want to create the hyperlink.

An example is shown in Figure 102.

6. If you are using WordPerfect, go to: “To create the hyperlink and produce a PDF in 
WordPerfect” below.

-or-

If you are using Word, go to: “To create the hyperlink and produce a PDF in Word” on 
page 120.

To create the hyperlink and produce a PDF in WordPerfect

1. From the Tools menu, choose Hyperlink.

The Hyperlink Properties dialog box opens. An example is shown in Figure 103.

2. Press Ctrl-V to paste the URL into the Document/Macro field.

Figure 102.  Highlight Hyperlink Text

Figure 103.  Hyperlink Properties Dialog Box
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3. If the citation is to a specific page in the document, append a string to the URL to identify the 
page: ?page=x 
For example: 
https://ecf.ca1.uscourts.gov/docs1/001010708409?page=23 

NOTE:  Because of an incompatibility between Internet Explorer and Adobe Acrobat, the page 
number pointer will not work if the user opens the document with Internet Explorer.

4. Click the OK button.

In the word processing application, the hyperlink text is now underlined and blue (or the color 
that you specified for hyperlinks), indicating a hyperlink has been created. 

5. Save the word processing document.

6. Produce the PDF file.

CAUTION:  Do not use the Print option in the word processing program.

If you are using a version of WordPerfect that has a Publish to PDF or Publish to option on 
the File menu, choose Publish to PDF or choose Publish to, then choose PDF. 

NOTE:  If you are using an earlier version of WordPerfect that does not have one of these 
Publish options, you must upgrade to Version 11 or higher.

You are now ready to file your document and upload the PDF with hyperlinks.

To create the hyperlink and produce a PDF in Word

1. From the Insert menu, choose Hyperlink.

The Insert Hyperlink dialog box opens. An example is shown in Figure 104.

Figure 104.  Insert Hyperlink Dialog Box
120 - ECF User Guide



Creating Cross-Document Hyperlinks >  Creating a Hyperlink to a Document Already Filed in a Case
2. Press Ctrl-V to paste the URL into the Address field.

3. If the citation is to a specific page in the document, append a string to the URL to identify the 
page: ?page=x 
For example: 
https://ecf.ca1.uscourts.gov/docs1/001010708409?page=23 

NOTE:  Because of an incompatibility between Internet Explorer and Adobe Acrobat, the page 
number pointer will not work if the user opens the document with Internet Explorer.

4. Click the OK button.

In the word processing application, the hyperlink text is now underlined and blue (or the color 
that you specified for hyperlinks), indicating a hyperlink has been created. 

5. Save the word processing document.

6. Produce the PDF file by following the steps below. 

CAUTION:  Do not use the Print option in the word processing program.

If you are using a version of Word that has an Adobe PDF menu, choose the Convert to Adobe 
PDF option.

If you are using Word but do not have an Adobe PDF menu, close the Word file and follow the 
steps below. 

a. Open Adobe Acrobat. 

b. From the File menu, choose Create PDF > From File.

A navigation dialog box opens. 

c. In the navigation dialog box, find and select the document that you want to convert to PDF, 
then click the Open button.

A series of dialog boxes open while the document is converted to PDF. When the 
conversion is complete, the document is displayed in an Adobe Acrobat window, with 
active hyperlinks (the ones you defined in the Word document).

d. Save the PDF file in a directory of your choice.

You are now ready to file your document and upload the PDF with hyperlinks.
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Creating Hyperlinks Between Documents in the 
Same Filing
Instead of linking to a previously-filed document, you can link a document to another document 
that you will be filing at the same time. For example, you could create a hyperlink from your main 
document to an attachment. 

When you create the link, it points to the referenced document where it exists on your local system 
or network and when the documents are filed in CM/ECF, the link is converted to an “address” in 
CM/ECF.

1. Create PDF versions of any secondary documents, such as attachments or exhibits, that will be 
referenced by the main document. 

2. Open the main document in the word processing program.

The main document is the document that will have hyperlinks to the secondary documents.

3. In the main document, highlight the text for which you want to create the hyperlink to the 
secondary document.

4. If you are using WordPerfect, go to: “To create the hyperlink to an attachment and produce a 
PDF in WordPerfect” below.

-or-

If you are using Word, go to: “To create the hyperlink to an attachment and produce a PDF in 
Word” on page 124.

To create the hyperlink to an attachment and produce a PDF in WordPerfect

1. From the Tools menu, choose Hyperlink.

The Hyperlink Properties dialog box opens. An example is shown in Figure 105.

Figure 105.  Hyperlink Properties Dialog Box
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2. Click the folder icon to the right of the Document/Macro field.

The Select File window opens.

3. Navigate to and select the PDF file that you want to link to and click the Select button.

The Document/Macro field in the Hyperlink Properties dialog box now shows the file you 
selected.

4. Click the OK button.

5. If the citation is to a specific page in the document, append a string to the value in the field to 
identify the page: ?page=x 
For example: 
C:\MyFiles\Exhibit-A.pdf?page=23 

NOTE:  Because of an incompatibility between Internet Explorer and Adobe Acrobat, the page 
number pointer will not work if the user opens the document with Internet Explorer.

6. Click the OK button.

In the word processing application, the hyperlink text is now underlined and blue (or the color 
that you specified for hyperlinks), indicating a hyperlink has been created. 

7. Save the word processing document.

8. Produce the PDF file.

CAUTION:  Do not use the Print option in the word processing program.

If you are using a version of WordPerfect that has a Publish to PDF or Publish to option on 
the File menu, choose Publish to PDF or choose Publish to, then choose PDF. 

NOTE:  If you are using an earlier version of WordPerfect that does not have one of these 
Publish options, you must upgrade to Version 11 or higher.

You are now ready to file your documents and upload the PDF with hyperlinks.
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To create the hyperlink to an attachment and produce a PDF in Word

1. From the Insert menu, choose Hyperlink.

The Insert Hyperlink dialog box opens. An example is shown in Figure 106.

2. Navigate to and select the PDF file that you want to link to.

3. The Address field in the Insert Hyperlink dialog box now shows the file you selected.

4. If the citation is to a specific page in the document, append a string to the value in the field to 
identify the page: ?page=x 
For example: 
C:\MyFiles\Exhibit-A.pdf?page=23 

NOTE:  Because of an incompatibility between Internet Explorer and Adobe Acrobat, the page 
number pointer will not work if the user opens the document with Internet Explorer.

5. Click the OK button.

In the word processing application, the hyperlink text is now underlined and blue (or the color 
that you specified for hyperlinks), indicating a hyperlink has been created. 

6. Save the word processing document.

Figure 106.  Insert Hyperlink Dialog Box
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7. Produce the PDF file by following the steps below. 

CAUTION:  Do not use the Print option in the word processing program.

If you are using a version of Word that has an Adobe PDF menu, choose the Convert to Adobe 
PDF option.

If you are using Word but do not have an Adobe PDF menu, close the Word file and follow the 
steps below. 

a. Open Adobe Acrobat. 

b. From the File menu, choose Create PDF > From File.

A navigation dialog box opens. 

c. In the navigation dialog box, find and select the document that you want to convert to PDF, 
then click the Open button.

A series of dialog boxes open while the document is converted to PDF. When the 
conversion is complete, the document is displayed in an Adobe Acrobat window, with 
active hyperlinks (the ones you defined in the Word document).

d. Save the PDF file in a directory of your choice.

You are now ready to file your documents and upload the PDF with hyperlinks.
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13 Macintosh Users and 
Appellate ECF

The topics below provide information specific to Macintosh users that will be useful when using 
Appellate ECF in the United States Court of Appeals for the Ninth Circuit.

The Apple Macintosh platform (Mac) can be used to run all parts of the ECF with no extra 
software. 

• “Prerequisites for Mac Users Running Mac OS X 10.7 or Higher” on page 127

• “Prerequisites for Mac Users Running Mac OS X 10.6 or Lower” on page 128

• “Things to do Before You Start: Java Version” on page 129

• “Things to do Before You Start: Choosing a Browser” on page 131

• “Starting ECF on a Mac” on page 135

• “Known Differences for Mac Users” on page 141

• “Known Java Issues for Mac Users” on page 143

• “Known PDF Viewer Issues for Mac Users” on page 147
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Prerequisites for Mac Users Running Mac OS X 
10.7 or Higher
The Court recommends that you have at least the following:

• Intel-based Mac running Mac OS X 10.7.3 (Lion) or later

• Java 7, latest update

• Administrator privileges for installation

• Safari or Firefox (Chrome is not supported)

NOTE:  Installing Java on a Mac is performed on a system-wide basis, for all users, and 
administrator privileges are required. You cannot install Java on a single-user basis.

NOTE:  If you are running an Intel-based Mac with OS X 10.7 (“Lion”) or higher and you have the 
recommended configuration below, you should be able to log in without any further configuration 
changes.
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Prerequisites for Mac Users Running Mac OS X 
10.6 or Lower
Both the hardware and the operating system (OS X) must be 64 bit. 

In summary, you need at least the following:

• 64-bit capable system

• OS X 10.5 or higher

• Java 1.6 Update 26 is recommended as the Java version for a Mac.

Apple released Java updates in May 2011 to patch vulnerabilities, and to increase reliability and 
compatibility.
Java for Mac OS X 10.6 Update 5 updates Java SE 6 to 1.6 Update 26.
Java for Mac OS X 10.5 Update 10 updates Java SE 6 to 1.6 Update 26 for 64-bit capable 
Intel-based systems.

You will not be able to log in if you have not installed this update. 

CAUTION:  Make sure you review the information in “Known Java Issues for Mac Users” on 
page 143 before you attempt to start ECF.

NOTE:  If you have an Intel-based Mac that is not 64-bit capable, you may be able to use one of the 
parallel operating system products, such as Fusion or Parallels, that allow a Mac to mimic the 
Windows operating system. Fusion and Parallels only run on Intel-based Mac systems.
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Things to do Before You Start: Java Version
1. From Finder, click Go, then click Applications.

2. In Applications, expand Utilities, then expand Java and double-click Java Preferences.

The Java Preferences dialog box opens.

3. Update the settings in the dialog box to match what is shown in Figure 107:

• Run applets: Within the browser process

• Java SE 6, 64-bit must be the first entry in the list. 

CAUTION:  If you do not see Java SE 6, you do not have the latest version of Java. In this case, 
download it from Apple, install the update and start again. See “To update your Java software” 
on page 130.

To check the Java version using a command window

1. Open the Hard Drive.

2. Click Applications, then Utilities.

3. Double-click Terminal to open a command window.

4. Type java -version and press the Return key. 

Figure 107.  Java Preferences Updated
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To update your Java software

1. Click the Apple logo in the upper left corner of the screen, then click Software Update.

A Software Update dialog box opens and when the system completes its check for updates to 
your software, a new dialog box opens that allows you to check the details of each update. An 
example is shown in Figure 108.

2. Click the Show Details button to see information about each update.

NOTE:  If Java does not appear in the list of updates, you already have the latest version.

3. Click the Install button and wait until the installation completes.

Figure 108.  Software Update
130 - ECF User Guide



Macintosh Users and Appellate ECF >  Things to do Before You Start: Choosing a Browser
Things to do Before You Start: Choosing a 
Browser
Decide which browser you want to use for ECF, define that browser as the default browser to use, 
and clear the browser cache and cookies. See one of the topics below for step-by-step instructions:

• “To set Firefox as the default browser and clear the browser cache and cookies” on page 131 

• “To set Safari as the default browser and clear the browser cache and cookies” on page 134

To set Firefox as the default browser and clear the browser cache and cookies

1. Open Firefox.

2. Choose Firefox > Preferences.

3. In the dialog box that opens, click the Advanced icon at the top, then make sure the General 
tab is the active tab.

4. At the bottom of the dialog box, under System Defaults, click the Check Now button to check 
and set Firefox as the default browser.
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5. Click the Privacy icon at the top and do the following:

a. From the Firefox will drop-down list, select Use custom settings for history.

b. Make sure the Accept cookies from sites and Accept third-party cookies checkboxes are 
selected. 

An example is shown in Figure 109. 

NOTE:  Depending on the version of Firefox that you are using, the illustration below may not 
exactly match what you see. Figure 109 shows the Cookies settings in Firefox 3.5.5.

Figure 109.  Cookies Section in Firefox Preferences
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6. Click the Show Cookies button.

The Cookies dialog box opens. An example is shown in Figure 110.

7. In the Cookies dialog box, click the Remove All Cookies button.

The Cookies dialog box should look similar to the one shown in Figure 111.

8. Close the Cookies dialog box, then close the Preferences dialog box.

Figure 110.  Cookies Dialog Box

Figure 111.  Cookies Dialog Box, After Remove All Cookies
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9. Click Tools, then click Clear Recent History.

The Clear Recent History dialog box opens. An example is shown in Figure 112.

10. Make sure the Cookies, Cache, and Active Logins checkboxes are all selected.

11. Click the Clear Now button.

12. Close the Clear Recent History dialog box.

To set Safari as the default browser and clear the browser cache and cookies

1. Open Safari.

2. Choose Safari > Preferences.

3. In the dialog box that opens, click the General icon at the top.

4. From the Default web browser drop-down list, select Safari.

5. In the dialog box, click the Security icon at the top.

6. Under Accept Cookies, click the Show Cookies button.

7. In the dialog box that opens, click the Remove All button, then click the Done button.

8. Close the Preferences dialog box.

9. Choose Safari > Empty Cache.

10. In the dialog box that opens, click the Empty button.

Figure 112.  Clear Recent History Dialog Box
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Starting ECF on a Mac
CAUTION:  Make sure you review the information in “Known Java Issues for Mac Users” on 
page 143 before you attempt to start ECF.

NOTE:  The launching process described in this topic has been tested using the Safari and the 
Firefox browsers. Other browsers may work.

After you enter your login and password and you click the Login button, the browser may ask what 
to do next. This one-time setup is to associate the Java Network Launching Protocol (JNLP) file 
with Java Web Start. The dialog box shown in Figure 113 opens.

1. If the dialog box shows Java Web Start in the drop-down list next to Open with, then 
select the Open with radio button and go to step Step 3 on page 138.

Figure 113.  Opening k2jnlp.jsp Dialog Box
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2. If you see a Choose button next to the Open with radio button, then click Choose to select the 
helper application.

A dialog box similar to the one shown in Figure 114 opens.

Do one of the following (depending on your version of Java, the location of Java Web Start may 
be different):

Figure 114.  Choose Helper Application
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• Under PLACES, click Applications, then find and click Utilities, then in the list on the 
right, find and click the entry labeled Java.

This shows the list of helper applications for Java, as shown in Figure 115.

Click Java Web Start and click the Open button.

Figure 115.  Choose Helper Application - PLACES
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• Under DEVICES, click Macintosh HD. Find and click System, then Library, then 
CoreServices, as shown in Figure 116.

Click Java Web Start and click the Open button.

3. Select the checkbox labeled Do this automatically for files like this from now on so that you 
do not have to do this twice. 

4. Click the OK button.

A Java Starting message box opens and then the system may ask you to authenticate the 
certificate. 

Figure 116.  Choose Helper Application - DEVICES
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5. If a certificate dialog box opens asking you if you want to accept the certificate from 
“ecf.ca9.uscourts.gov,” click the Trust button to continue.

Another certificate dialog box opens. This time, you must click the Trust button to ensure that 
ECF will be able to read PDF files from your Mac. The PDF certificate dialog box will look 
similar to the one shown in Figure 117.

Figure 117.  PDF Certificate
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6. Click the Trust button.

At this point, a small window with a blue CM/ECF label opens. This is the program itself. An 
example of this window is shown in Figure 118. 

CAUTION:  Do not close this window at any time. 

The Startup Page window opens in the foreground. Notice that your last login date and time are 
shown near the middle of the page. An example of this window is shown in Figure 119.

CAUTION:  Do not close the Startup Page window at any time. If you do close this window 
by accident, find the background window, shown in Figure 118, and click the large CM/ECF 
button.

Figure 118.  Appellate CM/ECF For Mac Background Window

Figure 119.  Appellate ECF For Mac Startup Page Window
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Known Differences for Mac Users
CAUTION:  Make sure you review the information in “Known Java Issues for Mac Users” on 
page 143 before you attempt to start ECF.

Longer Startup Process

In order to maintain the same security for the ECF application for all users, the URL used behind 
the scenes for downloading the program to the Mac is different each time. This will make the 
startup process take longer for Mac users, since the URL will not be cached.

Automatic Login as a PACER User

Automatic login as a PACER user when an attorney logs in as a filing user is not supported on the 
Mac.

The default Mac browser must be used to log in to ECF. If a secondary browser is used, it will not 
know that you are logged in when running browser-based portions of the system. To change the 
default browser, go to Safari > Preferences > General. Use the Default web browser to indicate the 
default web browser.
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Right-Click Functionality

There are a few areas in ECF Appellate which feature right-click functionality. Mac users can 
access the same features by going to System Preferences > Keyboard and Mouse > Trackpad, and 
selecting the checkbox labeled Tap trackpad using two fingers for secondary click. An 
illustration is shown in Figure 120.

Figure 120.  Secondary Click
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Known Java Issues for Mac Users
CM/ECF needs Java Web Start to run correctly on Mac systems. With the latest Java update from 
Apple, the location of Java Web Start has changed and you may have to manually identify that 
location.

If you have Safari and Mozilla Firefox, the Court recommends using Firefox to file 
electronically in order to avoid some of the issues described in this section.

Safari Browser is the Only Browser Installed on Your System
Assuming you followed the instructions for clearing the cache and cookies, you should be able to 
run CM/ECF without any problems.

Safari and Firefox Installed on Your System, Using Safari to Log In to CM/ECF
Assuming you followed the instructions for clearing the cache and cookies, and setting the default 
browser, you should be able to run CM/ECF to do your filings. However, PACER Report, Service 
List, and Help will open in a new Firefox window instead of the existing Safari window. As a result, 
the browser (Firefox) will not recognize that you are logged in to CM/ECF and will not allow you 
to run the reports. 

As a workaround, you can copy the URL from the Firefox window to a new tab in your Safari 
browser. For this reason, the Court recommends using Firefox to file electronically if you have both 
Safari and Firefox installed on your system.

Safari and Firefox Installed on Your System, Using Firefox to Log In to CM/ECF
Assuming you followed the instructions for clearing the cache and cookies, and setting the default 
browser, you should be able to run CM/ECF after following the steps below to find and identify 
Java Web Start:

1. Open Firefox.

2. Choose Firefox > Preferences.

3. In the dialog box that opens, click the Applications icon at the top.
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4. In the Content Type box (on the left) scroll down to JNLP File and select that entry.

By default, the Action for this Content Type is set to Use Java Web Start (default), as shown 
in Figure 121.

5. In the Action box (on the right), select Use Other.

CAUTION:  Do not select Use Java Web Start (default).

A window titled Select Helper Application opens.

Figure 121.  Applications - JNLP File Content Type, Default Setting
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6. In the Select Helper Application window, under DEVICES, 
click Macintosh HD > System > Library > CoreServices > Java Web Start.

Figure 122 shows an example of the correct selections.

Figure 122.  Select Helper Applications Window
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7. Click the Open button (at the bottom of the window).

The Select Helper Application window closes and the Preferences dialog box (Applications) 
now shows the correct selection for the JNLP file. An example is shown in Figure 123.

8. Close the Preferences dialog box.

9. Restart Firefox and then follow the instructions in “To set Firefox as the default browser and 
clear the browser cache and cookies” on page 131 before attempting to log in.

Figure 123.  Applications - JNLP File Content Type Updated
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Known PDF Viewer Issues for Mac Users
You may encounter issues when you try to open dynamic PDF forms from the Court’s website on 
a Mac system. Specifically, this problem has been reported for the Mediation Questionnaire, 
available here: http://www.ca9.uscourts.gov/uploads/forms/Mediation_Questionnaire.pdf.

The most common issue is a message saying that the PDF Viewer you have is not a supported 
version. Figure 124 shows an example of this message.

The reason you may see this message even though you have the latest version of Adobe Reader 
installed is that your Mac browsers are using the built in “Preview” application, which does not 
support dynamic PDF forms.

To resolve this issue, you must configure your browsers to use Adobe Reader instead of the default 
“Preview” application.

Firefox
Make Adobe Reader as a default PDF reader in Firefox:

1. Open Firefox.

2. Choose Firefox > Preferences.

3. In the dialog box that opens, click the Applications icon at the top.

Figure 124.  PDF Viewer Error Message
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4. Scroll down until you see Preview Document (application/pdf) in the Content Type column.

Select the Preview Document (application/pdf) entry, and in the Action column (the one on 
the right), select Use Adobe Reader (default) from the drop-down list. An example is shown in 
Figure 125.

5. Close the Preferences dialog box.

6. Restart Firefox and then try to access the dynamic PDF form again.

Safari

1. Open Finder.

2. Choose Go > Go to Folder.

3. In the dialog box that opens, in the Go to the folder field, type 
/Library/Internet Plug-Ins 
and click the Go button.

4. In the Internet Plug-ins folder, verify that AdobePDFViewer.plugin exists.

NOTE:  If you do not have this plugin, navigate to http://get.adobe.com/reader/ to download 
and install Adobe Reader.

Figure 125.  Applications - Preview Document (application/pdf) Updated
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5. Open Adobe Reader.

To do this, open Finder, choose Go > Applications, and then click Adobe Reader.

The following message should appear: “Adobe Reader is not currently configured to be the 
default application for pdf files. Would you like to make pdf files open with Adobe Reader 
instead of Preview?”
An example of this message is shown in Figure 126.

6. Click the Yes button.

7. Open Safari and navigate to the dynamic PDF form you want to open.

Figure 126.  Adobe Reader Message
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Appellate ECF

You can check your bar status via ECF, and if you are not admitted, you can submit your 
application for admission via ECF. You can also request duplicate admission certificates and 
certificates of good standing.

CAUTION:  Before you start, you must ensure that there are no pop-up blockers that prevent you 
from seeing the payment page. The payment window from Pay.gov opens in a new browser 
window or browser tab. 
The easiest way to check is to turn on the sound on your system, then try to access the Service List 
(Reports > Service List). If you hear a distinctive “ding,” you know that something is blocking the 
web page from opening. Make sure you change the pop-up blocker settings to allow all pop-ups 
from the Court’s site.

The following topics are included:

• “Submitting an Application for Admission With Fee Payment” on page 151

• “Requesting and Paying for a Certificate of Good Standing” on page 161

• “Requesting and Paying for a Duplicate Admission Certificate” on page 164

• “Reviewing Your Submissions and Payments” on page 167
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Submitting an Application for Admission With 
Fee Payment
Before you start, make sure you have your application for admission and any supporting 
documents ready to upload. All documents must be in PDF format.

CAUTION:  You may not, under any circumstances, submit an application for admission for 
another attorney. 

Submitting your application and paying the fee consist of entering the information the Court needs 
to process your application, uploading the PDF of your application, and completing the payment 
of the fee.

1. Entering state bar information and selecting PDF files to submit. See “To submit an application 
for admission” on page 152.
-or-
Submitting a fee payment if you were previously admitted with a fee waiver. See “To submit 
an application for admission if you were previously admitted with a fee waiver” on page 155.

2. Completing the payment of the fee. See “To pay and complete the transaction” on page 157.
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To submit an application for admission

1. In the Startup Page window, from the menu bar, choose Utilities > Bar Admission.

The Bar Admission window that opens will look similar to the one shown in Figure 127. 

NOTE:  If you are already admitted, you will not be able to submit a new application. An 
example of the Bar Admission window for an admitted attorney is shown in Figure 128. In this 
scenario, you can only upload PDF files to be attached to your admission record in the Court.

Figure 127.  Bar Admission, Attorney Not Admitted
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CAUTION:  If you were previously admitted as a federal government attorney (fee waived), and 
you want to submit your application for admission without a fee waiver (so you can receive a 
duplicate admission certificate), see “To submit an application for admission if you were 
previously admitted with a fee waiver” on page 155 instead.

2. In the State Bar Number field, type the state abbreviation and the state bar number.

3. If you are a former 9th circuit law clerk or a federal government attorney, select the appropriate 
Fee Waiver Reason from the drop-down list.

4. (Optional) Select a value from the State of Residence drop-down list.

Figure 128.  Bar Admission, Admitted Attorney
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5. Click the Browse button.

The Select PDF document dialog box opens. An example of this dialog box is shown in 
Figure 129. By default, the Select PDF document dialog box points to the last location you 
accessed to attach documents from within ECF.

6. Navigate to and select the PDF file you want to attach.

7. Click the Open button.

The Select PDF document dialog box closes and ECF shows the file you selected, with the full 
path, in the Document field.

8. In the Description field for the document, type a description of the PDF.

9. Repeat Step 5 - Step 8 for each PDF you want to submit.

10. Click the Pay Now and Submit Application button and complete the steps in “To pay and 
complete the transaction” on page 157.

Figure 129.  Select PDF document Dialog Box
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To submit an application for admission if you were previously admitted with a fee waiver
If you were previously admitted as a federal government attorney (fee waived), and you want to 
submit your application for admission without a fee waiver (so you can receive a duplicate 
admission certificate), you can submit the application and pay the fee using Appellate ECF.

1. In the Startup Page window, from the menu bar, choose Utilities > Bar Admission.

The Bar Admission window that opens will look similar to the one shown in Figure 130. 

2. Click the Update Fee button.

The system updates the Fee Amount to show the current fee.

Figure 130.  Bar Admission, Attorney Previously Admitted With Fee Waiver
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3. Click the Browse button.

The Select PDF document dialog box opens. An example of this dialog box is shown in 
Figure 131. By default, the Select PDF document dialog box points to the last location you 
accessed to attach documents from within ECF.

4. Navigate to and select the PDF file you want to attach.

5. Click the Open button.

The Select PDF document dialog box closes and ECF shows the file you selected, with the full 
path, in the Document field.

6. In the Description field for the document, type a description of the PDF.

7. Repeat Step 3 - Step 6 for each PDF you want to submit.

8. Click the Pay Now and Update Application button and complete the steps in “To pay and 
complete the transaction” on page 157.

Figure 131.  Select PDF document Dialog Box
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To pay and complete the transaction

1. Click the Pay Now and Submit Application or Pay Now and Update Application button to 
complete your payment and submit your application.

A new browser window or browser tab opens so that you can enter and submit your credit card 
information. The new browser window or tab may not automatically come to the front of your 
workspace. An example of a browser tab with the Step 1: Enter Payment Information page is 
shown in Figure 132.

CAUTION:  You are now connected to Pay.gov.

Figure 132.  Online Payment, Step 1
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2. Verify, change, and enter the information in the Step 1: Enter Payment Information page.

a. Verify and change the information in the Account Holder Name field and the billing 
address fields as needed.

CAUTION:  The name and address shown here are the name and address associated with 
your Appellate ECF account. If you are going to use a credit card that is not linked to the 
address we have on file for you, you must update the billing address.

b. Complete the Card Type, Card Number, Security Code and Expiration Date fields.

c. In the Attorney Name field, type the name of the attorney who logged in to ECF.

d. Complete the Contact Telephone Number and Person Completing Transaction fields so 
that the Court can contact you if there are any issues with the payment.

An example of a completed Step 1: Enter Payment Information page is shown in Figure 133.

Figure 133.  Online Payment, Step 1, Page Completed
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Bar Admission and Appellate ECF >  Submitting an Application for Admission With Fee Payment
3. Click the Continue with Plastic Card Payment button.

The Step 2: Authorize Payment page opens. 

4. In the Step 2: Authorize Payment page, make sure all the payment information is correct and 
type your email address(es) in the Email Address, Confirm Email Address, and CC fields.

The email address(es) you enter here will receive a payment confirmation email when the 
transaction has been processed.

5. Select the checkbox under Authorization and Disclosure.

An example of a completed Step 2: Authorize Payment page is shown in Figure 134.

Figure 134.  Online Payment, Step 2, Page Completed
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Bar Admission and Appellate ECF >  Submitting an Application for Admission With Fee Payment
6. Click the Submit Payment button.

CAUTION:  Wait for Pay.gov to process your payment. Do not click the button again.

When the transaction has completed, the confirmation page opens. An example is shown in 
Figure 135.

7. Click the Close Window button.

The Startup Page window is still open in the background. 

8. To review what you just submitted, see “Reviewing Your Submissions and Payments” on 
page 167.

9. To log out of Appellate ECF, bring the Startup Page window to the front and choose Logout > 
Logout CM/ECF.

Figure 135.  Final Confirmation Page
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Bar Admission and Appellate ECF >  Requesting and Paying for a Certificate of Good Standing
Requesting and Paying for a Certificate of Good 
Standing
You can use Appellate ECF to request and pay for certificate of good standing. 

1. In the Startup Page window, from the menu bar, choose
Utilities > Pay Miscellaneous Fees > Certificate of Good Standing.

A Certificate of Good Standing window opens. An example of this window is shown in 
Figure 136.

2. In the Quantity field, enter the number of certificates you want to receive from the Court.

The system automatically updates the Fee Amount.

3. Click the Browse button to attach a PDF with your current contact information.

Figure 136.  Certificate of Good Standing Window
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Bar Admission and Appellate ECF >  Requesting and Paying for a Certificate of Good Standing
4. Click the Pay Now and Submit button to complete your payment and submit the request to the 
Court.

A new browser window or browser tab opens so that you can enter and submit your credit card 
information. The new browser window or tab may not automatically come to the front of your 
workspace. 

An example of a browser tab with the Step 1: Enter Payment Information page is shown in 
Figure 132 on page 157.

CAUTION:  You are now connected to Pay.gov.

5. Verify, change, and enter the information in the Step 1: Enter Payment Information page.

a. Verify and change the information in the Account Holder Name field and the billing 
address fields as needed.

CAUTION:  The name and address shown here are the name and address associated with 
your Appellate ECF account. If you are going to use a credit card that is not linked to the 
address we have on file for you, you must update the billing address.

b. Complete the Card Type, Card Number, Security Code and Expiration Date fields.

c. In the Attorney Name field, type the name of the attorney who logged in to ECF.

d. Complete the Contact Telephone Number and Person Completing Transaction fields so 
that the Court can contact you if there are any issues with the payment.

e. Click the Continue with Plastic Card Payment button.

The Step 2: Authorize Payment page opens. 

An example of a completed Step 1: Enter Payment Information page is shown in Figure 133 on 
page 158.

6. In the Step 2: Authorize Payment page, make sure all the payment information is correct and 
type your email address(es) in the Email Address, Confirm Email Address, and CC fields.

The email address(es) you enter here will receive a payment confirmation email when the 
transaction has been processed.

7. Select the checkbox under Authorization and Disclosure.
An example of a completed Step 2: Authorize Payment page is shown in Figure 134 on 
page 159.
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Bar Admission and Appellate ECF >  Requesting and Paying for a Certificate of Good Standing
8. Click the Submit Payment button.

CAUTION:  Wait for Pay.gov to process your payment. Do not click the button again.

When the transaction has completed, the confirmation page opens. An example of a 
confirmation page is shown in Figure 137.

9. Click the Close Window button.

The Startup Page window is still open in the background. 

10. To review what you just submitted, see “Reviewing Your Submissions and Payments” on 
page 167.

11. To log out of Appellate ECF, bring the Startup Page window to the front and choose Logout > 
Logout CM/ECF.

Figure 137.  Final Confirmation Page
ECF User Guide -  163



Bar Admission and Appellate ECF >  Requesting and Paying for a Duplicate Admission Certificate
Requesting and Paying for a Duplicate 
Admission Certificate
You can use Appellate ECF to request and pay for duplicate admission certificate.

CAUTION:  If you were admitted as a federal government attorney (fee waived), you cannot order 
a duplicate admission certificate without paying the full admission fee. If you are in this situation, 
submit your application for admission and payment using Appellate ECF (see “To submit an 
application for admission if you were previously admitted with a fee waiver” on page 155) or call 
the Attorney Admissions clerk at the Court at 415-355-7800.

1. In the Startup Page window, from the menu bar, choose
Utilities > Pay Miscellaneous Fees > Dupl. Admission Certificate.

A Dupl. Admission Certificate window opens. An example of this window is shown in 
Figure 138.

2. In the Quantity field, enter the number of certificates you want to receive from the Court.

The system automatically updates the Fee Amount.

3. Click the Browse button to attach a PDF with your current contact information.

Figure 138.  Certificate of Good Standing Window
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Bar Admission and Appellate ECF >  Requesting and Paying for a Duplicate Admission Certificate
4. Click the Pay Now and Submit button to complete your payment and submit the request to the 
Court.

A new browser window or browser tab opens so that you can enter and submit your credit card 
information. The new browser window or tab may not automatically come to the front of your 
workspace. 

An example of a browser tab with the Step 1: Enter Payment Information page is shown in 
Figure 132 on page 157.

CAUTION:  You are now connected to Pay.gov.

5. Verify, change, and enter the information in the Step 1: Enter Payment Information page.

a. Verify and change the information in the Account Holder Name field and the billing 
address fields as needed.

CAUTION:  The name and address shown here are the name and address associated with 
your Appellate ECF account. If you are going to use a credit card that is not linked to the 
address we have on file for you, you must update the billing address.

b. Complete the Card Type, Card Number, Security Code and Expiration Date fields.

c. In the Attorney Name field, type the name of the attorney who logged in to ECF.

d. Complete the Contact Telephone Number and Person Completing Transaction fields so 
that the Court can contact you if there are any issues with the payment.

e. Click the Continue with Plastic Card Payment button.

The Step 2: Authorize Payment page opens. 

An example of a completed Step 1: Enter Payment Information page is shown in Figure 133 on 
page 158.

6. In the Step 2: Authorize Payment page, make sure all the payment information is correct and 
type your email address(es) in the Email Address, Confirm Email Address, and CC fields.

The email address(es) you enter here will receive a payment confirmation email when the 
transaction has been processed.

7. Select the checkbox under Authorization and Disclosure.
An example of a completed Step 2: Authorize Payment page is shown in Figure 134 on 
page 159.
ECF User Guide -  165



Bar Admission and Appellate ECF >  Requesting and Paying for a Duplicate Admission Certificate
8. Click the Submit Payment button.

CAUTION:  Wait for Pay.gov to process your payment. Do not click the button again.

When the transaction has completed, the confirmation page opens. An example of a 
confirmation page for an initial admission fee is shown in Figure 135 on page 160.

9. Click the Close Window button.

The Startup Page window is still open in the background. 

10. To review what you just submitted, see “Reviewing Your Submissions and Payments” on 
page 167.

11. To log out of Appellate ECF, bring the Startup Page window to the front and choose Logout > 
Logout CM/ECF.
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Bar Admission and Appellate ECF >  Reviewing Your Submissions and Payments
Reviewing Your Submissions and Payments
You can review a history of the original petitions you submitted and the payments you made.

To review your submissions and payments
• In the Startup Page window, from the menu bar, choose Reports > History Report.

A new browser window or browser tab opens with the report. 

This report shows a history of the PDF files you submitted using the functions in the Utilities 
menu and the payments you made through Pay.gov. This report does not show a history of 
filings or submissions you did in cases via the Filing menu, except fee payments.
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15 Updating Your Appellate 
ECF Account

Since the Court is now live with Electronic Filing, all filers must update their own accounts. Do 
not send the Court notices of change of address or change of name, instead, follow the instructions 
in one of the following topics:

• “Updating a Company Name or Company Address” on page 169

• “Updating Your Email and Address When you Move to a Different Firm” on page 174
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Updating Your Appellate ECF Account >  Updating a Company Name or Company Address
Updating a Company Name or Company 
Address
CAUTION:  Follow the steps in this topic only if the name or address of your company has changed. 
If you changed firms, follow the instructions in “Updating Your Email and Address When you 
Move to a Different Firm” on page 174 instead.

For at least one attorney in your firm, do the following:

1. Navigate to https://www.pacer.gov/psco/cgi-bin/cmecf/ea-login.pl.

The login page is shown in Figure 139.

Figure 139.  Appellate Filer Account Update, Login Page
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Updating Your Appellate ECF Account >  Updating a Company Name or Company Address
2. Enter the attorney’s login and password and click the Login button.

The Appellate CM/ECF Filer Account Update page opens. This page has three tabs: 
Maintenance, History, and Miscellaneous, as shown in Figure 140.

3. In the Maintenance tab, click the Personal Info/Address/ECF Filing Status Updates link.

A page opens with one tab labeled Personal Info/Address Updates. An example is shown in 
Figure 141.

Figure 140.  Appellate CM/ECF Filer Account Update Page

Figure 141.  Personal Info/Address Updates Tab
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Updating Your Appellate ECF Account >  Updating a Company Name or Company Address
4. In the Personal Info/Address Updates tab, click the Update Address Info link (the second 
link from the bottom of the list).

NOTE:  You may have to update your “default” address. See “Updating the “Default” Address 
Linked to Your Appellate ECF Account” on page 172 for instructions.

A screen opens with one tab labeled Address Maintenance. The system shows the address 
currently on file for the account. An example is shown in Figure 142.

5. Click the Update button to the right of the address.

A screen opens with one tab labeled Update Address Information.

6. Make your changes to update the firm’s information (name, phone number, address).

Figure 142.  Address Maintenance Tab
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Updating Your Appellate ECF Account >  Updating a Company Name or Company Address
7. Select the checkbox labeled Check here if this address change applies to the entire firm, as 
shown in Figure 143.

8. Click the Submit button to submit your changes to the PACER Service Center.

A confirmation page opens to let you know that your request has been sent to the PACER 
Service Center.

9. Click the OK button to return to the main Appellate CM/ECF Filer Account Update page.

10. Click the Logout link at the top of the page.

Updating the “Default” Address Linked to Your Appellate ECF 
Account

To update the default address linked to your account

1. Navigate to https://www.pacer.gov/psco/cgi-bin/cmecf/ea-login.pl.

2. Enter the attorney’s login and password and click the Login button.

The Appellate CM/ECF Filer Account Update page opens. This page has three tabs: 
Maintenance, History, and Miscellaneous.

3. In the Maintenance tab, click the Personal Info/Address/ECF Filing Status Updates link.

A page opens with one tab labeled Personal Info/Address Updates. 

Figure 143.  Checkbox to Indicate that Change Applies to Firm
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Updating Your Appellate ECF Account >  Updating a Company Name or Company Address
4. In the Personal Info/Address Updates tab, click the Update Default Address Info link (the 
first link in the list).

A screen opens with one tab labeled Update Address Information. The system shows the 
default address currently on file for the account.

5. Make your changes to update the firm’s information (name, phone number, address).

6. Click the Submit button to submit your changes to the PACER Service Center.

A confirmation page opens to let you know that your request has been sent to the PACER 
Service Center.

7. Click the OK button to return to the main Manage My Appellate Filer Account page.

The change is submitted to the PACER Service Center and the main Manage My Appellate 
Filer Account page opens.
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Updating Your Appellate ECF Account >  Updating Your Email and Address When you Move to a Different Firm
Updating Your Email and Address When you 
Move to a Different Firm
CAUTION:  Follow the steps in this topic only if you changed firms and you need to update your 
company address and other contact information, such as phone numbers and email addresses. If the 
name of your firm has changed or if your firm moved to a new address, follow the instructions in 
“Updating a Company Name or Company Address” on page 169 instead.

1. Navigate to https://www.pacer.gov/psco/cgi-bin/cmecf/ea-login.pl.

The login page is shown in Figure 144.

Figure 144.  Appellate Filer Account Update, Login Page
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Updating Your Appellate ECF Account >  Updating Your Email and Address When you Move to a Different Firm
2. Enter the attorney’s login and password and click the Login button.

The Appellate CM/ECF Filer Account Update page opens. This page has three tabs: 
Maintenance, History, and Miscellaneous, as shown in Figure 145.

3. In the Maintenance tab, click the Personal Info/Address/ECF Filing Status link.

A page opens with one tab labeled Personal Info/Address Updates. An example is shown in 
Figure 146.

4. In the Personal Info/Address Updates tab, click the Update Personal Info link.

Figure 145.  Appellate CM/ECF Filer Account Update Page

Figure 146.  Personal Info/Address Updates Tab
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Updating Your Appellate ECF Account >  Updating Your Email and Address When you Move to a Different Firm
5. In the Change Personal Information tab in the page that opens, update the Primary E-Mail 
Address and Verify Primary E-Mail fields with your new email address.

An example is shown in Figure 147.

6. Click the Submit button.

A confirmation page opens to let you know that your request has been sent to the PACER 
Service Center.

7. Click the OK button to return to the main Appellate CM/ECF Filer Account Update page.

8. In the Maintenance tab, click the Personal Info/Address/ECF Filing Status link.

A page opens with one tab labeled Personal Info/Address Updates. An example is shown in 
Figure 148.

Figure 147.  Update Email Address

Figure 148.  Update Data Tab
176 - ECF User Guide



Updating Your Appellate ECF Account >  Updating Your Email and Address When you Move to a Different Firm
9. In the Personal Info/Address Updates tab, click the Update Address Info link.

A screen opens with one tab labeled Address Maintenance. The system shows the address 
currently on file for the account. An example is shown in Figure 149.

10. Click the Update button to the right of the address.

A screen opens with one tab labeled Update Address Information.

11. Make your changes to reflect your new firm and its contact information.

12. Click the Submit button to submit your changes to the PACER service center.

13. A confirmation page opens to let you know that your request has been sent to the PACER 
Service Center.

14. Click the OK button to return to the main Appellate CM/ECF Filer Account Update page.

15. Click the Logout link at the top of the page.

Figure 149.  Address Maintenance Tab
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16 Filing Categories and 
Types of Motions

This chapter provides a complete list of the ECF filing categories and types of motions you can file. 

• “Filing Category: Briefs” on page 179

• “Filing Category: Motions/Responses/Replies” on page 180

• “Filing Category: Rehearing/Reconsideration” on page 185

• “Filing Category: Court Reporters” on page 186

• “Filing Category: Original Petitions” on page 187

• “Filing Category: Appeals Pursuant to FRAP 9(a)” on page 188

• “Filing Category: Forms/Notices/Disclosures” on page 189

• “Filing Category: Correspondence/Status Reports” on page 190

• “Filing Category: Prospective Amici and Intervenors” on page 191

• “Filing Category: Pay Case Opening Fees” on page 192

An example of part of the File a Document window with the Motions/Responses/Replies category 
selected is shown in Figure 150. Filing categories appear on the left. When you select a category 
on the left, the filing types for that category appear on the right.

Figure 150.  Filing Category: Motions/Responses/Replies
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Filing Categories and Types of Motions >  Filing Category: Briefs
Filing Category: Briefs
The following filing types are available in the Briefs category:

• Submit Brief for Review by the Court

• Submit Brief for Review and File a Motion Together
For a list of the types of motions that you can file, see “Types of Motions Available When 
Submitting a Brief and Filing a Motion Together” on page 179.

• File an Errata to a Brief

• File a Citation of Supplemental Authorities (FRAP 28(j) Letter)

• File a Notice of Joint Brief Under 9th Cir. R. 28-4 (Form 7)

• File a Streamlined Request to Extend Time to File Brief

• Submit Excerpts of Record for Review by the Court

• File Presentence Report UNDER SEAL

Types of Motions Available When Submitting a Brief and Filing a 
Motion Together

You select the type of motion using the Relief area. “Selecting Reliefs for a Filing” on page 59 
provides step-by-step instructions on how to use the Relief area.

• motion to file a late brief

• motion to file nonstandard brief

• motion to file oversized brief

• motion to file substitute or corrected brief

• motion to file supplemental brief

• motion to reinstate case after FRAP 42-1 dismissal

• motion to withdraw as counsel
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Filing Categories and Types of Motions >  Filing Category: Motions/Responses/Replies
Filing Category: Motions/Responses/Replies
The following filing types are available in the Motions/Responses/Replies category:

• File a Motion

For a list of the types of motions that you can file, see “Types of Motions Available When Filing 
a Motion” on page 181.

• File a Response to a Motion/Form

• File a Motion and a Response to a Motion Together

For a list of the types of motions that you can file, see “Types of Motions Available When Filing 
a Motion” on page 181.

• File a Reply to a Response to a Motion

• File a Response to an Order to Show Cause

• File a Response to a Court Order

• File a Reply to a Response to an Order to Show Cause

• File a Reply to a Response to a Court Order

• File a Motion for Reconsideration from Dispositive Order

• File a Motion for Reconsideration from Non-Dispositive Order

• Submit Brief for Review and File a Motion Together

See “Filing Category: Briefs” on page 179 for additional information.

• File a Court Reporter Motion to Extend Time

See “Filing Category: Court Reporters” on page 186 for additional information.

• File an Answer to an Original Petition

• File a Reply to an Answer to an Original Petition
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Filing Categories and Types of Motions >  Filing Category: Motions/Responses/Replies
Types of Motions Available When Filing a Motion

You select the type of motion using the Relief area. “Selecting Reliefs for a Filing” on page 59 
provides step-by-step instructions on how to use the Relief area.

• motion for 46-5 exemption

• motion for appointment of counsel

• motion for appointment of pro bono counsel

• motion for attorney fees

• motion for bail pending appeal or trial

• motion for certificate of appealability

• motion for certification to state supreme court

• motion for injunction pending appeal

• motion for miscellaneous relief (to be used only if no other relief applies)

• motion for sanctions

• motion for summary affirmance

• motion for summary disposition

• motion for summary reversal

• motion to assign case to prior panel

• motion to compel supplementation of excerpts of record

• motion to complete production of reporters transcript at government expense

• motion to consolidate cases

• motion to continue hearing

• motion to dismiss case for failure to prosecute under Circuit Rule 42-1

• motion to dismiss for lack of jurisdiction

• motion to dismiss party from case

• motion to dismiss the case

• motion to dismiss the case voluntarily pursuant to rule 42b

• motion to expedite case

• motion to extend time to comply with order
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Filing Categories and Types of Motions >  Filing Category: Motions/Responses/Replies
• motion to extend time to file COA request

• motion to extend time to file FRAP 9a memorandum

• motion to extend time to file Mediation Questionnaire

• motion to extend time to file agency record

• motion to extend time to file appellant designation of reporters transcript

• motion to extend time to file appellee designation of reporters transcript

• motion to extend time to file appendix

• motion to extend time to file bill of costs

• motion to extend time to file brief

• motion to extend time to file opposition

• motion to extend time to file petition for rehearing

• motion to extend time to file record on appeal

• motion to extend time to file reply

• motion to extend time to file response

• motion to file a late brief

• motion to file addendum

• motion to file appendix

• motion to file joint brief

• motion to file late opposition (to file motion and opposition together)

• motion to file late petition for rehearing (to file motion and petition for rehearing on same day)

• motion to file nonstandard brief

• motion to file oversized brief

• motion to file oversized petition for rehearing

• motion to file substitute or corrected brief

• motion to file supplemental brief

• motion to file supplemental briefing for petition for rehearing

• motion to file supplemental excerpts of record

• motion to hear case with other case
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Filing Categories and Types of Motions >  Filing Category: Motions/Responses/Replies
• motion to join in existing brief

• motion to lift stay

• motion to present oral argument by video

• motion to proceed in forma pauperis

• motion to recall mandate

• motion to refer case to mediation

• motion to reinstate case after FRAP 42-1 dismissal

• motion to remand case

• motion to request publication of memorandum disposition

• motion to reschedule oral argument

• motion to stay lower court action

• motion to stay proceedings

• motion to stay proceedings pending settlement

• motion to stay removal/deportation

• motion to stay the mandate

• motion to strike portion or whole of document

• motion to submit case on briefs

• motion to substitute counsel

• motion to substitute party

• motion to supplement or amend Mediation Questionnaire

• motion to supplement or amend designation of reporters transcript

• motion to supplement record on appeal

• motion to take judicial notice

• motion to transfer appeal to other circuit

• motion to transmit exhibit

• motion to unseal document

• motion to waive filing of excerpts of record

• motion to waive filing of motion to supplement or amend Mediation Questionnaire
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• motion to withdraw as counsel
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Filing Categories and Types of Motions >  Filing Category: Rehearing/Reconsideration
Filing Category: Rehearing/Reconsideration
The following filing types are available in the Rehearing/Reconsideration category:

• File a Petition for Panel Rehearing (FRAP 40; 9th Cir. R. 40-1)

• File a Petition for Rehearing En Banc (FRAP 35; 9th Cir. R. 35-1)

• File a Combination Petition for Panel Rehearing/En Banc (FRAP 35, 40)

• File an Answer or Response to a Petition for Rehearing/En Banc

• File a Reply to a Response to a Petition for Rehearing/En Banc

• File a Motion for Reconsideration from Dispositive Order

• File a Motion for Reconsideration from Non-Dispositive Order
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Filing Categories and Types of Motions >  Filing Category: Court Reporters
Filing Category: Court Reporters
The following filing types are available in the Court Reporters category:

• File a Court Reporter Motion to Extend Time

• File Court Reporter Correspondence to Court

• File a Notice of Reporter Default (9th Cir. R. 11-1.2)
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Filing Category: Original Petitions
The following filing types are available in the Original Petitions category:

• File an Answer to an Original Petition

• File a Reply to an Answer to an Original Petition
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Filing Categories and Types of Motions >  Filing Category: Appeals Pursuant to FRAP 9(a)
Filing Category: Appeals Pursuant to FRAP 9(a)
The following filing types are available in the Appeals Pursuant to FRAP 9(a) category:

• File a FRAP 9(a) Memorandum

• File a Response to a FRAP 9(a) Memorandum

• File a Reply to a Response to a FRAP 9(a) Memorandum

NOTE:  To file a motion to extend time to file a FRAP 9(a) memorandum, you must file a motion, 
and then select the motion to extend time to file FRAP 9a Memorandum relief. See “Filing a 
Motion” on page 88 for step-by-step instructions.
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Filing Categories and Types of Motions >  Filing Category: Forms/Notices/Disclosures
Filing Category: Forms/Notices/Disclosures
The following filing types are available in the Forms/Notices/Disclosures category:

TIP:  Download fill-in forms from the Court’s website: http://www.ca9.uscourts.gov/forms. Save 
the form you want to your hard drive.You must have Adobe Acrobat to save a fill-in form. If you 
do not have Adobe Acrobat, you may scan the filled in form to attach it to your filing.

• File a Response to a Motion/Form

• File a Notice of Appearance or Re-Assignment

• File a Mediation Questionnaire

• File Affidavit Accompanying In Forma Pauperis Motion (Form 4)

• File a CJA Form 23 Financial Affidavit

• File a Corporate Disclosure Statement (FRAP 26.1)

• File a Notice of Joint Brief Under 9th Cir. R. 28-4 (Form 7)

• File an Acknowledgment of Hearing Notice

• File a Bill of Costs (Form 10)

• File an Application for Fees Under EAJA

• File a Certification for Law Student Representation Form

• File a Client Authorization of Law School Representation

• File a Notice of Reporter Default (9th Cir. R. 11-1.2)
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Filing Categories and Types of Motions >  Filing Category: Correspondence/Status Reports
Filing Category: Correspondence/Status 
Reports
The following filing types are available in the Correspondence/Status Reports category:

• File a Citation of Supplemental Authorities (FRAP 28(j) Letter)

• File a Status Report Required by Court Order

• File Correspondence to Court

• File Court Reporter Correspondence to Court

See “Filing Category: Court Reporters” on page 186 for additional information.

• File a Notice of Reporter Default (9th Cir. R. 11-1.2)
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Filing Categories and Types of Motions >  Filing Category: Prospective Amici and Intervenors
Filing Category: Prospective Amici and 
Intervenors
The following filing types are available in the Prospective Amici and Intervenors category:

• File a Corporate Disclosure Statement (FRAP 26.1)

• File a Prospective Amicus or Intervenor Motion

For a list of the types of motions that you can file, see “Types of Motions Available When Filing 
a Prospective Amicus or Intervenor Motion,” below.

• Submit Brief and File Prospective Amicus or Intervenor Motion Together

For a list of the types of motions that you can file, see “Types of Motions Available When Filing 
a Prospective Amicus or Intervenor Motion,” below.

• Submit Amicus Brief With Consent per FRAP 29(a)

CAUTION:  You may only use this filing type if the party you represent is a government agency 
or if you have written consent by all parties to file this amicus brief. If you use this filing type 
in error, the clerk will not be able to process the filing and you will have to redo your filing 
using the correct filing type and include a motion with the filing.

Types of Motions Available When Filing a Prospective Amicus or 
Intervenor Motion

You select the type of motion using the Relief area. “Selecting Reliefs for a Filing” on page 59 
provides step-by-step instructions on how to use the Relief area.

• motion to become amicus

• motion to extend time to file amicus brief

• motion to extend time to file intervenor brief

• motion to intervene
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Filing Categories and Types of Motions >  Filing Category: Pay Case Opening Fees
Filing Category: Pay Case Opening Fees
CAUTION:  If you filed a notice of appeal in another court, you must pay the filing and appeal fees 
in that court. Do not pay the fee in the U.S. Court of Appeals.

The following filing type is available in the Pay Case Opening Fees category:

• Pay Fee for Agency Petition/Petition for Writ of Mandamus
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